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  Editorial


  Welcome to the latest issue of Full Circle


  As ever, we have the usual suspects of Python, Inkscape, Krita and Rawtherapee, and the second part of the new series on creating podcasts in Linux.


  Long time readers of FCM will know that my first brush with Linux was with Kubuntu and KDE (3.5) many moons ago. I gave up on it when KDE4.0 arrived on the scene (unusable), briefly returned when it stabilised at 4.5, but left again when Plasma 5 came along as it didn't have a GUI for my graphics tablet. Well, a couple of weeks ago I decided to give the latest Kubuntu Live DVD a try. Just for old time sakes. And, wouldn't you know it, they've added the missing graphics tablet GUI! I'm not sure when it was added, but I duly installed Kubuntu 20.04.1 and it feels good to be back. I'm still not sure why they quickly abandoned KDE 4 for Plasma 5. I just hope they don't suddenly abandon Plasma 5 now that I've installed it.


  One issue that I had, on installing Kubuntu 20.04.1, was that I had no sound. I tried all sorts of possible solutions. I could see (in Pavucontrol) that the sound was being produced as the little bar jumped up and down to the inaudible sound. Only after several days of head scratching did I find my solution. It turns out my PC has two output jacks and Kubuntu had decided to switch jacks. I only found the second jack after much crawling on my knees with a torch under my desk. That reminds me, I need get the hoover out...


  Stay safe and well!


  All the best, and keep in touch!


  Ronnie


  ronnie@fullcirclemagazine.org
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    FCM PATREON : https://www.patreon.com/fullcirclemagazine
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  NEWS


  Submitted by ErikTheUnread


  
    Full Circle Weekly News
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    The show is also available via:


    
      	RSS: http://fullcirclemagazine.org/feed/podcast


      	Stitcher Radio: http://www.stitcher.com/s?fid=85347&refid=stpr


      	TuneIn Radio: http://tunein.com/radio/Full-Circle-Weekly-News-p855064/


      	PlayerFM: https://player.fm/series/the-full-circle-weekly-news

    


    Enjoy! Ronnie

  


  


  A new version of Julia released:


  08/03/2020


  The Julia 1.5 programming language has been released, combining qualities such as high performance, support for dynamic typing and built-in tools for parallel programming. Julia's syntax is close to MATLAB, with some elements borrowing from Ruby and Lisp. The string manipulation method is similar to Perl. The project code is distributed under the MIT license.


  https://julialang.org/blog/2020/08/julia-1.5-highlights


  The OpenSSF project was established:


  08/03/2020


  The Linux Foundation has announced the formation of a new joint project, OpenSSF (Open Source Security Foundation), to bring together the work of industry leaders in the field of improving the security of open source software. The OpenSSF will continue to develop initiatives such as the Core Infrastructure Initiative and the Open Source Security Coalition and will bring together other security-related work being undertaken by the companies that have joined the project. OpenSSF's work will focus on areas such as coordinated vulnerability disclosure and patch distribution, developing security tools, publishing secure development best practices, identifying security threats in open source software, conducting audits and hardening critical open source projects, creating tools to verify the identity of developers.


  https://www.linuxfoundation.org/press-release/2020/08/technology-and-enterprise-leaders-combine-efforts-to-improve-open-source-security


  Mastodon 3.2 released:


  08/04/2020


  The free platform for the deployment of decentralized social networks - Mastodon 3.2 , is out. It allows you to create services at your own facilities that are not controlled by individual suppliers. If the user is unable to start his own node, then he can choose a trustworthy public service to connect. Mastodon belongs to the category of federated networks, which use the ActivityPub protocol suite to form a single communication structure . The server side of the project is written in Ruby using Ruby on Rails, while the client interface is written in JavaScript using the React.js and Redux libraries. Source code is distributed under the AGPLv3 license.


  https://blog.joinmastodon.org/2020/08/mastodon-3.2


  Vala programming language 0.49.1:


  08/04/2020


  A new version of the compiler for the Vala programming language 0.49.1 has been released. The Vala language provides syntax similar to C # and Java, and provides easy integration with libraries written in C, both using the Glib Object System (Gobject) and can work stand-alone.


  https://www.mail-archive.com/release-team@gnome.org/msg08542.html


  Pale Moon Browser Release 28.12:


  08/04/2020


  Pale Moon 28.12 web browser has been released , forked from the Firefox codebase to provide better performance, preserve the classic interface, minimize memory consumption and provide additional customization options. Pale Moon binaries are built for Windows and Linux (x86 and x86_64). The project code is distributed under the MPLv2 license (Mozilla Public License).


  https://forum.palemoon.org/viewtopic.php?t=24954&p=196294


  Boothole fix, fixed:


  08/05/2020


  Major Linux distributions have issued a corrective update to the GRUB2 bootloader package to address issues that have arisen since the BootHole vulnerability. After installing the first update, some users faced the inability to boot their systems. Boot problems occurred on some systems with BIOS or UEFI in "Legacy" mode, and were caused by regressive changes, in certain situations, leading to crash during the boot process or incorrect definition of the boot device and incorrect installation of the boot loader.


  https://lists.ubuntu.com/archives/ubuntu-security-announce/2020-August/005549.html


  Fedora 33 Launches Official IoT Revision


  08/05/2020


  Peter Robinson from Red Hat Release Engineering Team team published a proposal on the adoption of options for IOT in the Fedora 33 official edition. Thus, from Fedora 33, IoT version will be delivered on a par with Fedora and Fedora Workstation Server. The proposal has not yet been officially approved, but its publication was previously approved by the FESCo (Fedora Engineering Steering Committee), which is responsible for the technical part of the development of the Fedora distribution, so its acceptance can be considered a formality.


  https://www.mail-archive.com/devel-announce@lists.fedoraproject.org/msg02341.html


  Wayfire 0.5 composite server available:


  08/05/2020


  The release of the composite server Wayfire 0.5, which uses Wayland and allows you to create resource-friendly user interfaces with 3D effects similar to 3D plugins for Compiz. (Switching screens through a 3D cube, spatial layout of windows, morphing when working with windows, etc.) Wayfire supports extensions via plug-ins and provides a flexible customization system.


  The project code is written in C++ and is distributed under the MIT license. For the base, wlroots library is used, developed by the developers of the Sway user environment and providing basic functions for organizing the work of a composite manager based on Wayland. You can use wf-shell or LavaLauncher as a panel.


  https://wayfire.org/2020/08/04/Wayfire-0-5.html


  LibreOffice 7.0 released:


  08/05/2020


  The Document Foundation presents the release of the office suite LibreOffice 7.0. Ready-made installation packages are prepared for various Linux, Windows and macOS distributions, as well as for deploying an online version in Docker . For the release, 74% of the changes were made by people in charge of the project such as Collabora, Red Hat, and CIB, and 26% of the changes were contributed by independent enthusiasts.


  https://blog.documentfoundation.org/blog/2020/08/05/announcement-of-libreoffice-7-0


  Pinta 1.7 is out:


  08/05/2020


  Five years after the last release, the release of the open raster graphics editor Pinta 1.7 is available for download. It is an attempt to rewrite the Paint.NET program using GTK. The editor provides a basic set of drawing and image processing capabilities, targeting novice users. The interface is simplified as much as possible, the editor supports an unlimited roll-back buffer, allows you to work with multiple layers and is equipped with a set of tools for applying various effects and adjusting images. Pinta code is licensed under the MIT license. The project is written in C# using Mono and the Gtk # binding. Binary builds are available for Ubuntu, macOS and Windows.


  https://www.pinta-project.com/releases/1-7


  Jeffrey Knauth Elected New President of the Free Open Source Foundation:


  08/06/2020


  The Free Software Foundation has announced the election of a new president, after the departure from this post by Richard Stallman after allegations of behaviour not befitting a leader of a SPO movement and threats to break with some of the open source software communities and organizations. The new president is Geoffrey Knauth, who has served on the Free Software Foundation's board of directors since 1998 and has been a member of the GNU Project since 1985.


  https://www.fsf.org/news/geoffrey-knauth-elected-free-software-foundation-president-odile-benassy-joins-the-board


  Ubuntu 20.04.1 LTS released:


  08/06/2020


  Canonical has unveiled the first patch release of Ubuntu 20.04.1 LTS, which includes updates for several hundred packages to address vulnerabilities and stability issues. The new version also fixes errors in the installer and loader. The Ubuntu 20.04.1 release marked the baseline stabilization of the LTS release - Ubuntu 18.04 users will now be prompted to upgrade to the 20.04 branch.


  At the same time, similar updates are available for Ubuntu Budgie 20.04.1 LTS, Kubuntu 20.04.1 LTS, Ubuntu MATE 20.04.1 LTS, Ubuntu Studio 20.04.1 LTS, Lubuntu 20.04.1 LTS, Ubuntu Kylin 20.04.1 LTS and Xubuntu 20.04.1 LTS. Support for the release of updates and security fixes for the server and desktop editions of Ubuntu 20.04 LTS will last until April 2025.


  https://lists.ubuntu.com/archives/ubuntu-announce/2020-August/000259.html


  PHP 8 beta testing has begun:


  08/06/2020


  The first beta release of a new branch of the PHP 8 programming language is available for you to check out. The release is scheduled for November 26. At the same time, bug-fix releases of PHP 7.4.9, 7.3.21 and 7.2.33 were made.


  https://www.php.net/archive/2020.php#2020-08-06-3


  AMD Radeon 20.30 Video Driver:


  08/07/2020


  AMD has published a set of drivers AMD Radeon 20.30 for Linux, based on the free module AMDGPU core, for proprietary and open-video drivers. Open and proprietary driver stacks are integrated in one AMD Radeon set - amdgpu-pro and amdgpu-all-open drivers (RADV vulkan driver and RadeonSI OpenGL driver based on code from Mesa) are offered in one package and the user can choose open or closed drivers.


  https://www.amd.com/en/support/kb/release-notes/rn-amdgpu-unified-linux-20-30


  Firefox Reality PC Preview for VR Devices introduced:


  08/07/2020


  Mozilla has introduced a new revision of the browser for virtual reality systems - Firefox Reality PC Preview . The browser supports all of Firefox's privacy features, but offers a different three-dimensional user interface that allows you to navigate sites within the virtual world or as part of augmented reality systems. Builds are available for installation through the HTC Viveport catalog (for now, only for Windows 10). It works with all 3D headsets supported by the Viveport platform, including Vive Cosmos, Vive Pro, Valve Index, Oculus Rift and Oculus Rift S.


  https://blog.mozvr.com/introducing-firefox-reality-pc-preview


  Elementary OS 5.1.7 update:


  08.08.2020


  Elementary OS 5.1.7, positioned as a fast, open and privacy-friendly alternative to Windows and MacOS, is out. The main focus of the project is on quality design aimed at creating an easy-to-use system that consumes minimal resources and provides a high start-up speed. Users are offered their own Pantheon desktop environment.


  When developing original components of Elementary OS, GTK3, Vala and Granite's own frameworks are used. The distribution kit is based on the Ubuntu project. Elementary OS 5.1.x is compatible with Ubuntu 18.04 at the package and repository level. The graphical environment is based on its own Pantheon shell, which combines such components as the Gala window manager (based on LibMutter), the WingPanel top panel, the Slingshot launcher, the Switchboard control panel, the Plank lower taskbar (the Docky panel rewritten in Vala) and the session manager Pantheon Greeter (based on LightDM).


  https://blog.elementary.io/updates-for-july-2020


  Apache http server 2.4.46 released with vulnerability fixes:


  08.08.2020


  HTTP-server, Apache 2.4.46 (4.2.44 and 2.4.45 releases were skipped), represents 17 changes and eliminated three vulnerabilities : CVE-2020-11984, CVE-2020-11984, CVE-2020-9490


  https://www.mail-archive.com/announce@httpd.apache.org/msg00146.html


  Akira, a new vector graphics editor for Linux, is available:


  08/09/2020


  The first test release of Akira, focused on graphic designers and web designers for creating interface layouts, has been published. The program is written in the Vala language using the GTK library and is distributed under the GPLv3 license. Builds are prepared for elementary OS and in universal snap and flatpak formats. The interface is designed in accordance with the guidelines prepared by the elementary OS project, and is focused on high performance, intuitiveness, and a modern look. The ultimate goal of the project is to create a professional tool for front-end designers, somewhat similar to Sketch, Figma or Adobe XD, but focused on using Linux as the main platform. Unlike Glade and Qt Creator, the new editor is not designed to generate code or use specific toolkits, but is aimed at solving more general tasks, such as creating interface layouts, visualizations, and vector graphics.


  https://github.com/akiraux/Akira


  RetroArch Game Console Emulator 1.9.0 released:


  08/09/2020


  A new release of RetroArch 1.9.0, for emulating various game consoles, allowing you to run classic games using a simple unified graphical interface is available for download. Emulation of consoles, like Atari 2600/7800 / Jaguar / Lynx, Game Boy, Mega Drive, NES, Nintendo 64 / DS, PCEngine, PSP, Sega 32X / CD, SuperNES, etc. are supported. Game pads from existing game consoles can be used, including Playstation 3, Dualshock 3, 8bitdo, XBox 1 and XBox360. The emulator supports advanced features such as multiplayer games, saving state, enhancing the image of old games with shaders, rewinding games, hot plugging game consoles and video streaming.


  https://www.libretro.com/index.php/retroarch-1-9-0-released


  Vulnerability in Ghostscript that could allow code execution when opening a PostScript document:


  08/10/2020


  A vulnerability has been identified in Ghostscript, a set of tools for processing, converting and generating PostScript and PDF documents. (CVE-2020-15900) It could lead to file modification and arbitrary command execution when opening specially formatted PostScript documents. Using the non-standard PostScript operator rsearch in a document allows you to cause an overflow of the uint32_t type when calculating the size, overwrite memory areas outside the allocated buffer and gain access to files in the file system, which can be used to organize an attack to execute arbitrary code on the system (for example, by adding commands to ~ / .bashrc or ~ / .profile).


  The problem affects releases from 9.50 to 9.52 https://insomniasec.com/blog/ghostscript-cve-2020-15900


  KDE Neon based on Ubuntu 20.04:


  08/10/2020


  The developers of the KDE Neon project, have published a stable release based on Ubuntu 20.04 LTS. There are several build options for KDE Neon: User Edition based on the latest stable releases of KDE, Developer Edition Git Stable based on code from beta- and stable branches of the KDE Git repository, and Developer Edition Git Unstable based on development branches from Git.


  https://blog.neon.kde.org/index.php/2020/08/10/kde-neon-rebased-on-20-04/


  GhostBSD 20.08 Released:


  08/10/2020


  GhostBSD 20.08 desktop distribution is now available, built on the TrueOS platform and offering a MATE user environment. GhostBSD uses the OpenRC init system and the ZFS file system. Both work in Live mode and installation on a hard disk is supported (using its own installer, ginstall, written in Python). Boot images are built for x86_64. The new version has updated the base system, kernel and applications, including the new release of the MATE desktop 1.24 . An option has been added to the update manager to back up the boot environment before installing the update.


  http://ghostbsd.org/20.08.04_release_announcement


  Finnix 121, the Live distribution for system administrators:


  08/10/2020


  Finnix 121 Live is based on Debian. The distribution is console only, but contains a good selection of utilities for the needs of an administrator. The structure includes 591 packages with all kinds of utilities. The size of the iso image is 509 MB.


  "In the new version, we switched to using the Debian testing branch instead of the stable releases." New packages for ranger, cpu-checker, edid-decode, ipmitool, lldpd, oathtool, sdparm, sipcalc, socat, xorriso, zfs-fuse are included.


  https://blog.finnix.org/2020/08/10/finnix-121-released/


  GNU Emacs 27.1 Text Editor:


  08/11/2020


  The GNU Project has released the GNU Emacs 27.1 text editor. Until the release of GNU Emacs 24.5, the project was developed under the personal direction of Richard Stallman, who handed over the project lead to John Wiegley in the fall of 2015.


  https://www.mail-archive.com/info-gnu@gnu.org/msg02771.html


  QEMU 5.1 emulator released:


  08/12/2020


  As an emulator, QEMU allows you to run a program built for one hardware platform on a system with a completely different architecture, for example, an application for ARM on an x86-compatible PC. In virtualization mode in QEMU, the performance of code execution in an isolated environment is close to the native system due to direct execution of instructions on the CPU and the use of the Xen hypervisor or the KVM module.


  The project was originally created by Fabrice Bellard to enable x86-built Linux binaries to run on non-x86 architectures. Over the years of development, support for full emulation has been added for 14 hardware architectures, the number of emulated hardware devices has exceeded 400. During the preparation of version 5.1, more than 2500 changes were made from 235 developers.


  https://lists.nongnu.org/archive/html/qemu-devel/2020-08/msg02152.html


  422 thousand copies of LibreOffice 7.0 downloaded in a week:


  08/12/2020


  The Document Foundation has released download statistics for the week following the release of LibreOffice 7.0 . LibreOffice 7.0.0 is reported to have been downloaded 422 thousand times. The press release about the new issue was viewed 113 thousand times, and the video with an overview of innovations - 48 thousand.


  https://blog.documentfoundation.org/blog/2020/08/12/libreoffice-7-0-a-week-in-stats/


  Go programming language release 1.15:


  08/12/2020


  Go 1.15 is being developed by Google with the participation of the community as a hybrid solution that combines high performance of compiled languages with such advantages of scripting languages as ease of writing code, speed of development and protection from errors. The project code is distributed under the BSD license.


  Go's syntax is based on familiar C language elements with some from Python. The project is initially developed with an eye on multi-threaded programming and efficient operation on multi-core systems, including providing operator-level tools for organizing parallel computations and interaction between parallel executed methods. The language also provides built-in protections against out-of-range allocated blocks of memory and provides the ability to use a garbage collector.


  https://blog.golang.org/go1.15


  CAELinux Engineering Distribution 2020:


  08/13/2020


  A new release of CAELinux 2020 is available. It is built on the Xubuntu 18.04 base and features an expanded selection of specialized applications aimed at automating engineering tasks, mathematical modeling and scientific activities. The size of a bootable iso image capable of working in Live mode is 5.8 GB (x86_64).


  https://www.caelinux.com/CMS3/index.php/articles/70-/61-caelinux-202020-released


  Drovorub malware for Linux:


  08/13/2020


  The National Security Agency and the US Federal Bureau of Investigation published a report according to which the 85th main center of the special service of the Main Directorate of the General Staff of the Armed Forces of the Russian Federation (85 GTSSS GRU) is using a malware complex called Drovorub. Drovorub includes a rootkit in the form of a Linux kernel module, a file transfer and port forwarding tool, and a management server. The client part can download and upload files, execute arbitrary commands as the root user, and redirect network ports to other hosts on the network.


  https://media.defense.gov/2020/Aug/13/2002476465/-1/-1/0/CSA_DROVORUB_RUSSIAN_GRU_MALWARE_AUG_2020.PDF


  KDE Apps Release 20.08:


  08/13/2020


  The August Cumulative Update of Applications (20.08) developed by the KDE Project is out. In total, 216 programs, libraries and plugins were published. Information on new releases of applications can be found on this page:


  https://kde.org/announcements/releases/2020-08-apps-update/


  LTS releases of Ubuntu 18.04.5 and 16.04.7:


  08/14/2020


  Ubuntu 18.04.5 LTS update has been preleased. This is the final update that includes changes related to improved hardware support, updates to the Linux kernel and graphics stack, and fixes for installer and bootloader bugs. In the future, updates for the 18.04 branch will be limited to the elimination of vulnerabilities and problems affecting stability. Similar updates are out for Kubuntu 18.04.5 LTS, Ubuntu Budgie 18.04.5 LTS, Ubuntu MATE 18.04.5 LTS, Lubuntu 18.04.5 LTS, Ubuntu Kylin 18.04.5 LTS and Xubuntu 18.04.5 LTS.


  Concurrently, Ubuntu 16.04.7 LTS update, which includes only the accumulated package updates related to the elimination of vulnerabilities and problems affecting stability, was released. The main goal of the new release is to update the installation images. As in the previous release, Linux kernels 4.15 and 4.4 are offered, as well as Mesa, X.Org Server ported from Ubuntu 18.04, and video drivers for Intel, AMD and NVIDIA chips. Support for the release of updates and security fixes for the server and desktop editions of Ubuntu 16.04 LTS will last until April 2021.


  https://lists.ubuntu.com/archives/ubuntu-announce/2020-August/000260.html


  Mcron 1.2 released, the GNU project's cron implementation:


  08/14/2020


  After two years of development, the release of the GNU Mcron 1.2 project was announced. In the new release, a big code cleanup has been carried out - all the C code has been rewritten and the project now includes only the Guile source code. The key feature of the project is a different approach to organizing work execution scheduling - instead of constantly monitoring the time, Mcron uses jobs in a linear queue with the definition of delays between calls to each element of the queue. In the periods between activating jobs, mcron is completely inactive. This approach significantly reduces cron overhead and increases the accuracy of job firing.


  https://lists.gnu.org/archive/html/info-gnu/2020-08/msg00004.html


  SQLite 3.33 DBMS released:


  08/15/2020


  SQLite 3.33.0, a lightweight DBMS designed as a plug-in library, is available for download. SQLite code is distributed as a public domain, i.e. can be used without restrictions and free of charge for any purpose. SQLite developers are financially supported by a specially created consortium of companies such as Adobe, Oracle, Mozilla, Bentley and Bloomberg.


  https://www.sqlite.org/changes.html


  Paragon Software publishes NTFS GPL implementation for Linux kernel:


  08/16/2020


  Konstantin Komarov, founder and CEO of Paragon Software, has posted a set of patches with a full implementation of the NTFS file system. (RW) The code is under the GPL license. The driver is based on the existing commercial Paragon Software product code and is well tested. The patches are designed for Linux and do not contain any bindings to additional APIs, which allows the new driver to be included in the main kernel. Once the patches are included in the main Linux kernel, Paragon Software intends to provide maintenance, bug fixes and functionality enhancements.


  https://lore.kernel.org/linux-fsdevel/2911ac5cd20b46e397be506268718d74@paragon-software.com/


  The Kosmonaut browser engine written in Rust:


  08/16/2020


  The Kosmonaut project is developing a browser engine written entirely in Rust and using some of the developments of the Servo project. The code is distributed under the MPL 2.0 license (Mozilla Public License). For rendering, the OpenGL gl-rs bindings in Rust are used. Window management and OpenGL context creation are implemented by the Glutin library. For parsing HTML and CSS, the html5ever and cssparser components developed by the Servo project are used. The DOM code is based on the Kuchiki project. Among the projects used, the experimental web-engine Robinson is also mentioned, which has been in a semi-abandoned state for about 5 years.


  At the current stage of development, basic HTML support and a limited set of CSS capabilities are provided, which are not yet sufficient for viewing most modern pages. However, simple CSS div pages render correctly.


  https://github.com/twilco/kosmonaut


  Hacked build server and compromised Libretro community repositories developing RetroArch:


  08/17/2020


  The Libretro community, who develop the RetroArch game console emulator and distribution kit for creating Lakka game consoles, has warned of hacking of the project infrastructure and vandalism in the repositories. Attackers were able to gain access to the buildbot and repositories on GitHub. Fortunately, the vandalism was blocked by the developers before the attackers got to the key RetroArch repository.


  https://www.libretro.com/index.php/hacker-vandalised-our-buildbot-and-github-organization/


  Notepad++ blocked in China:


  08/17/2020


  The developers of Notepad++, announced the project lock out in China. Despite supporting only Windows, Notepad ++ editor is very popular among Ubuntu users and is ranked 5th among the most popular snap-packages for developers (runs via Wine).


  It is believed that the reason for blocking Notepad ++ was the project's participation in actions against discrimination against Uighurs and in support of protesters in Hong Kong.The latest release, 7.8.9, was flagged as support for Hong Kong freedom and autonomy, and releases 7.8.1 through 7.8.3 came with a call against Uyghur harassment.


  https://twitter.com/Notepad_plus/status/1294991670245818369


  Release of Kdenlive 20.08:


  08/17/2020


  Kdenlive 20.08, is positioned for semi-professional video editing use. It supports working with video recordings in DV, HDV and AVCHD formats and provides all the basic video editing operations. For example, it allows you to randomly mix video, sound and images using the timeline and also apply numerous effects. The program uses external components such as FFmpeg, MLT framework and Frei0r effects design system. An AppImage self-contained package is available for installation.


  https://kdenlive.org/en/2020/08/kdenlive-20-08-is-out/


  Hacked build server and compromised Libretro community repositories of RetroArch:


  08/17/2020


  The Libretro community, who develop the RetroArch game console emulator and the distribution kit for creating Lakka game consoles, has warned of hacking of the project infrastructure and vandalism in the repositories. Attackers were able to gain access to the buildbot and repositories on GitHub. Fortunately, the vandalism was blocked by the developers before the attackers got to the key RetroArch repository.


  https://www.libretro.com/index.php/hacker-vandalised-our-buildbot-and-github-organization/


  Notepad++ blocked in China:


  08/17/2020


  The developers of Notepad++, announced the project is blocked in China. Despite supporting only Windows, Notepad ++ editor is very popular among Ubuntu users and is ranked 5th among the most popular snap-packages for developers (runs via Wine).


  It is believed that the reason for blocking Notepad++ was the project's participation in actions against discrimination against Uighurs and in support of protesters in Hong Kong. The latest release, 7.8.9, was flagged as support for Hong Kong freedom and autonomy, and releases 7.8.1 through 7.8.3 came with a call against Uyghur harassment.


  https://twitter.com/Notepad_plus/status/1294991670245818369


  Video editor Kdenlive 20.08 released:


  08/17/2020


  Kdenlive 20.08, which is positioned for semi-professional use, supports working with video recordings in DV, HDV and AVCHD formats, and provides all the basic video editing operations. For example, it allows you to randomly mix video, sound and images using the timeline and also apply numerous effects. The program uses external components such as FFmpeg, MLT framework and Frei0r effects design system. An AppImage self-contained package is available for installation.


  https://kdenlive.org/en/2020/08/kdenlive-20-08-is-out/


  OpenRCT2 is out:


  08/18/2020


  A new version of the OpenRCT2 project has been published, an open- source implementation of the strategy game RollerCoaster Tycoon 2, which simulates the construction and management of an amusement park. OpenRCT2 code is available under the GPLv3 license. The new release is notable for the support for connecting your own plugins in JavaScript, the ability to import scripts in the ".sea" format (RCT Classic), the implementation of some features from the first RollerCoaster Tycoon game.


  In addition to the attractions themselves, the OpenRCT2 game also covers infrastructure elements such as shops and cafes. The player's task is to make a profit, maintain a good image and attract visitors. You need original files with data from the game RollerCoaster Tycoon 2 CD. It supports modern platforms, an improved interface, improved AI, additional editing tools and the possibility of multiplayer games.


  https://github.com/OpenRCT2/OpenRCT2/releases/tag/v0.3.0


  MX Linux 19.2 distribution with KDE desktop:


  08/18/2020


  A new edition of MX Linux 19.2, shipped with the KDE desktop (Xfce shipped in the main edition) is available for download. This is the first official build with the KDE desktop since the MEPIS project collapsed in 2013. The release is based on the Debian with improvements from the antiX project and numerous proprietary applications to make it easier to configure and install software.


  https://mxlinux.org/blog/mx-19-2-kde-now-available/


  Parrot 4.10 released:


  08/18/2020


  Parrot 4.10 is available, based on Debian Testing and including a collection of tools for system security testing, forensic analysis and reverse engineering. Several iso images are offered for download with MATE environment, with a KDE desktop and with an Xfce desktop


  The Parrot distribution is positioned as a portable laboratory with an environment for security experts and forensic experts. It also includes cryptographic tools and secure network access software, including TOR, I2P, anonsurf, gpg, tccf, zulucrypt, veracrypt, truecrypt and luks.


  https://parrotsec.org/blog/parrot-4.10-release-notes/


  Kali Linux 2020.3 Release:


  08/19/2020


  Kali the Linux 2020.3 , designed to test systems for vulnerabilities, audit, analysis of residual data and to identify the consequences of malicious attacks. All original applications created within the distribution are distributed under the GPL license and are available through the public Git repository. There are several variants of iso-images for download.


  https://www.kali.org/news/kali-2020-3-release/


  Solaris 11.4 SRU24 available:


  08/19/2020


  The Solaris 11.4 SRU 24 (Support Repository Update) operating system update is out, which offers a series of regular fixes and improvements for the Solaris 11.4 branch. To install the fixes proposed in the update, simply run the 'pkg update' command.


  https://blogs.oracle.com/solaris/announcing-oracle-solaris-114-sru24


  FritzFrog worm detected, infecting servers via SSH and building a decentralized botnet:


  08/20/2020


  Data center and cloud security company Guardicore has identified a new high-tech malware called FritzFrog that infects Linux-based servers. FritzFrog combines a worm that spreads through a bruteforce attack on servers with an open SSH port and components to build a decentralized botnet that works without control nodes and does not have a single point of failure.


  According to researchers, the botnet already has about 500 nodes, including servers of several universities and a large railway company. The main target of the attack is the networks of educational institutions, medical centers, government agencies, banks and telecommunications companies. After the server is compromised, the process of mining Monero cryptocurrency is started on it. The activity of the malware in question has been traced since January 2020.


  https://www.guardicore.com/2020/08/fritzfrog-p2p-botnet-infects-ssh-servers/


  Microsoft ported WSL2 to Windows 10 1903 and 1909:


  08/21/2020


  Microsoft announced support for the Windows Subsystem for Linux ( WSL2 ) in Windows 10 1903 and 1909 released in May and November of last year. The WSL2 subsystem, which runs Linux executable files on Windows, was originally introduced with the Windows 10 2004 release. Microsoft has now ported this subsystem into past Windows 10 updates, which remain relevant and are used by many enterprises. Maintenance for releases 1903 and 1909 will last until December 2020 and May 2022.


  https://devblogs.microsoft.com/commandline/wsl-2-support-is-coming-to-windows-10-versions-1903-and-1909/


  BIND DNS server update 9.11.22, 9.16.6, 9.17.4, fixing 5 vulnerabilities


  08/21/2020


  A bug-fix update for BIND stable branches, as well as in the development of experimental branches is out. 5 vulnerabilities have been fixed in new releases. The most dangerous vulnerability ( CVE-2020-8620 ) allows remote denial of service by sending a specific set of packets to the TCP port on which BIND connections are accepted. Sending abnormally large AXFR requests to the TCP port may cause the libuv library serving the TCP connection to transfer the size to the server, which triggers the assertion check and terminates the process.(CVE-2020-8621-24)


  https://www.mail-archive.com/bind-announce@lists.isc.org/msg00579.html


  Kaidan XMPP client 0.6.0 released


  08/23/2020


  A new version of the Kaidan XMPP client 0.6.0 is available. The program is written in C++ using Qt, QXmpp and the Kirigami framework. The code is distributed under the GPLv3 license. Binaries are available for Linux ( AppImage and flatpak ) and Android. The release of macOS and Windows binaries are delayed.


  A key improvement in the new version is the implementation of the offline message queue - when there is no network connection, messages are now cached and automatically sent when the network connection is restored.


  https://www.kaidan.im/2020/08/20/kaidan-0.6.0/


  Zextras now making binaries for Zimbra 9 Open Source Edition:


  08/23/2020


  Zextras has begun to publish binaries of the Zimbra 9 collaboration and email package, positioned as an alternative to MS Exchange. The binaries are for Ubuntu and RHEL respectively.


  Earlier, the company Synacor, which oversees the development of Zimbra, announced the termination of the publication of binaries for Zimbra Open Source Edition and the intention to develop Zimbra 9 as a proprietary product without publishing new changes to the community. Later, Synacor reconsidered its decision to publish the sources and continued to publish changes to GitHub , but refused to generate binaries. In response, Zextras, which is involved in the development of Zimbra, began publishing binaries on its website.


  https://www.zextras.com/ru/zimbra-9/
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    The Ubuntu Podcast covers all the latest news and issues facing Ubuntu Linux users and Free Software fans in general. The show appeals to the newest user and the oldest coder. Our discussions cover the development of Ubuntu but aren’t overly technical. We are lucky enough to have some great guests on the show, telling us first hand about the latest exciting developments they are working on, in a way that we can all understand! We also talk about the Ubuntu community and what it gets up to.


    The show is presented by members of the UK’s Ubuntu Linux community. Because it is covered by the Ubuntu Code of Conduct it is suitable for all. The show is broadcast live every fortnight on a Tuesday evening (British time) and is available for download the following day. podcast.ubuntu-uk.org
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  Command & Conquer - Rust Part 5


  Written by Erik


  Website: https://doc.rust-lang.org/book/


  Okay rustafarians, we head back to Rust development – @Daredevil14 and Ellin complained about where Lucas’ rust blog went. It looks like you guys want more rust and less ‘security nonsense’. Firstly, do not neglect to read the above book. If you are a complete beginner to rust, or even programming, we got you covered here at FCM. These articles are not to replace the book mentioned above, think of it more as helpers along the way.


  At the moment, we are just taking a high-level view of things. We can drill down into each of these topics we have covered in more detail. Usually when you want to define custom types, it’s ‘structs’ and ‘enums’. Let’s start with structs?


  This will be chapter five in the book above. This is the direct link: https://doc.rust-lang.org/book/ch05-01-defining-structs.html


  Structs group things together, like your character stats in a RPG game. So let’s say we create a character in our RPG. Characters have a name, they have a strength attribute, a dexterity attribute, etc. These “characteristics” are the same across any player, be it a half elf or an ogre. If you are not familiar with RPG games or DND, quickly look up DND (or D&D) character creation on the interwebs. I did not like the example here: https://doc.rust-lang.org/rust-by-example/custom_types/structs.html. But, if it makes more sense to you than my example, please go ahead on that page.


  Like other things in Rust, we let Rust know what we are defining, so we use the struct keyword.


  struct PlayerCharacter
{
    name: String,
    gender: String,
    race: String,
    Strength: u8,
    Agility: u8,
    Constitution: u8,       
    Charisma: u8,
}



  What you are looking at is a CSV (Comma Separated Values) just neatly below each other. You can think of them as fields in an excel or calc worksheet.


  So we define our struct character creation sheet, but how do we actually use it? Well, to use it, you need to remember to use all the fields that you created. So for demonstration purposes, I am not going to type all those fields we listed above, but a subsection of them. We will encounter an error, but the program will run. (I do not use all the fields, that’s all).


  **You may have noticed an odd semicolon after the player definition. I was like, why is that there? I say it is because it is an assignment statement, even if it doesn’t look that way at first. However, here is more opinions: https://users.rust-lang.org/t/why-is-a-semicolon-required-at-the-end-of-a-tuple-struct-definition/25589


  The important take-away here is the how. How to use a struct. We can step through the code:
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  We define our variable “player” as assigned to the struct name, “PlayerCharacter”.


  **Just a reminder, variables are not variable in Rust unless you use the mut keyword. So if you plan on changing these variables, say strength or agility as your character levels up, you need mut after let.


  We then fill all the defined fields, if we plan on using them immediately or not. (You will notice that I did not use them and I got compiler errors. If you follow along, you can ignore these for now and you will see the desired output). We end our assignment statement with a semicolon. Think of it as a struct instance.


  So what is happening in the println? When you reference the field you want, you need “variablename.fieldname” . The reason for this is that you may have multiple PlayerCharacters, and referring to each may be player1.name, player2.name (instead of my lame character.name). See where this is going?


  I have to point out that structs with named fields are not the only type. The first is a tuple struct. In a tuple struct the fields are immutable, so they do not need naming.


  Okay I just watched this: https://www.youtube.com/watch?v=wh4aWZRtTwU - this morning, so don’t judge my example. It is actually HARD coming up with simple examples!


  Code:


  Struct Colour(u32, u32, u32);

fn main()
{
   let Colour1 = Colour(150,75,0);

   println!(“Dark orange is {}, {}, {} in RGB.”, Colour.0, Colour.1, Colour.2);
   println!(“Brown is {}, {}, {} in RGB.”, Colour.0, Colour.1, Colour.2);
}



  We simply refer to the position of the tuple’s contents.


  ***A tuple struct is not the same type as a tuple!


  I can’t imagine a real-world use case, but my day job is not a programmer, so if anyone wants to jump in here, please feel free!!!


  A unit struct is the other type. This is a struct without any fields. I cannot say what use they would be, but we can discuss that in the next issue when we look at enums.


  If I made a mistake *wink, fix it and send it to: misc@fullcirclemagazine.org


  
    Erik has been in IT for 30+ years. He has seen technology come and go. From repairing washing machine sized hard drives with multimeters and oscilloscopes, laying cable, to scaling 3G towers, he's done it.
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  How To - Python in the REAL World - Part 108


  Written by Greg Walters


  Welcome back. I truly hope that everyone is healthy. Here in central Texas, it’s been hot. Air temperature of 104°F (40°C) with a heat index well over 107 for days, and it’s expected to continue for at least the next 7 days.


  Last month, I started showing you the pyFPDF library. This month (FCM #160), we will be continuing to look at this library and examining the Templating portion of the library.


  My assumption was that the Templating feature was originally designed to handle things like invoices and labels. Furthermore, I thought that this could easily be used to produce things like recipe printouts or anything else that you wanted to have certain data show up at some preset X/Y position on a page and rendered into a PDF file. I was partially right, but it seems that pyFPDF is not completely up to the task for my needs without a tonne of work.


  I’ll start with a sample of a recipe from my cookbook database that represents a “normal” single page recipe that would or could be printed. In its current “state”, the cookbook program creates an html page on the fly based on the recipe that needs to be printed, then sends it to the default browser for printing. It looks something like this…
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  Not the prettiest, I have to admit, but it does the job and handles situations where a user needs a paper copy of the recipe (like if a friend who just can’t live without the recipe) as well as recipes that have lots of ingredients and/or lots of instructions, and flows into two or three pages.


  Back to the pyFPDF library; at first glance, the documentation is fairly sparse when it comes to some of the options. Most of it made sense and seemed to be reasonably easy to translate into what I was hoping to do. Well, I was really wrong. It IS sparse and some of the information is confusing. I’ll address this as we go.


  Since I almost always provide the code and most everything you need to run the demos I create for these articles, I didn’t want to attempt to provide the entire database. There are over 300 recipes and images (in a separate folder), and I really don’t think that pastebin will let me upload a sql database and that many images (or images at all). Therefore, I created a simple program to extract 3 “normal” single-page recipes and hard coded them into a series of “records” which are then dumped into lists for each table. Then, with a printout of the recipes on my clipboard and my ruler in hand, I started to dissect the XY coordinates of where I wanted to put each of the elements.
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  I decided to use the hardcode method of defining the elements rather than the CSV method, since I wasn’t sure how everything would work and fit together. If it worked, then I could always create a CSV directly later on. I’m really glad I didn’t. You’ll understand later.


  *Due to the use of f-strings, you will need to use Python 3.7.4 or greater. * I started with the header and recipe title. That went pretty well and I was able to get those two elements defined. With one of the sample programs, I started to copy and paste from their sample into my code.


  Here is a shortened example of the element structure…


  # Template...
elements = [
    {
        'name': 'header', 'type': 'T',
        'x1': 17.0, 'y1': 8.0,
        'x2': 0, 'y2': 0,
        'font': 'Arial', 'size': 8,
        'bold': 0, 'italic': 0,
        'underline': 0, 'foreground': 0,
        'background': 0, 'align': 'L',
        'text': '', 'priority': 2,
    },
    {
        'name': 'title', 'type': 'T',
        'x1': 17, 'y1': 26,
        'x2': 0, 'y2': 0,
        'font': 'Arial', 'size': 22,
        'bold': 1, 'italic': 1,
        'underline': 0, 'foreground': 0,
        'background': 0, 'align': 'L',
        'text': '', 'priority': 2,
    },
    {
        'name': 'recipeimage', 'type': 'I',
        'x1': 17, 'y1': 25,
        'x2': 80, 'y2': 89,
        'font': None, 'size': 0,
        'bold': 0, 'italic': 0,
        'underline': 0, 'foreground': 0,
        'background': 0, 'align': 'L',
        'text': 'image', 'priority': 2,
    },
    …
}



  As you can see, it’s a list of dictionaries. We’ll break one of them down…


  
    	Name is the name you want to reference it by


    	Type is the type of element this is defining. The documented options are: 'T': texts, 'L': lines, 'I': images, 'B': boxes, 'BC': barcodes (more on this in a moment).


    	X1, Y1, X2, Y2 are the xy positions of an imaginary box. Upper left to lower right.


    	Next comes the font specifications, foreground/background definitions, alignment, text (if any) and the priority for the Z-order of the element. The text can be overridden when calling the element.


    	There is also an optional multiline attribute, which, if used, will be the last in the dictionary.

  


  Now in the documentation, the Type specification shows only these 5 options. However, by digging into the code of the library, there is one other. It is “W” for write. It was added to allow (url) links in templates (using write method), but can be used in other situations. The good news for this option is that it works similar to the function that we created last month called chapter_body. It allows for multiline paragraph type text to be rendered correctly in a “flowing” manner.


  From what I could see from my limited testing, the priority (Z-Order) doesn’t make a difference what value you use. I didn’t spend a tremendous amount of time on that part of the testing.


  I was somewhat concerned about the image type, since the images I use are not a standard size. Since most are scraped from the web, some will be in landscape mode and some in portrait mode. Some are rather large and others fairly small. Luckily, the rendering image resizes the image to fit within the bounds set in the XY positioning.


  Now, let’s take a look at the Ingredients section of the PDF. I really wanted to have the header and the text of the list to align as left-justified, similar to the printout image at the top of the article. For the list of ingredients (and the instructions) I ended up having to use the “W” write method. The normal “T” text method, with multiline set to True (it uses the multi_cell method internally), didn’t work correctly. The only drawback is a visual one which forces an indent for the first line of the “paragraph”. While this is nice for a chapter paragraph, it looks (at least to me) wrong, and is somewhat distracting.
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  Here’s the element definitions for the ingredientshead and ingredientitems, which is very similar to the instructions section...


     {
        'name': 'ingreidentshead', 'type': 'T',
        'x1': 17, ‘'y1': 220, 'x2': 0, 'y2': 0,
        'font': 'Arial', 'size': 12, 'bold': 1,
        'italic': 1, 'underline': 0, 
        'foreground': 0, 'background': 0,
        'align': 'L', 'text': 'Ingredients:',
        'priority': 2,
    },
    {
        'name': 'ingredientitems', 'type': 'W',
        'x1': 17, 'y1': 115, 'x2': 90, 'y2': 400,
        'font': 'Arial', 'size': 11, 'bold': 0,
        'italic': 0, 'underline': 0,
        'foreground': 0, 'background': 0,
        'align': 'L', 'text': '',
        'priority': 2, 'multiline': True
    },



  Notice that the y1 position for the static text “Ingredients” is at 220 while the ingredient items block is set at 115. To me, this makes no sense. The same thing occurs with the instructions static text and the flowing text of the instructions.


  Now that we have our data defined and the elements dictionary set up (see the full code for all the elements definition), all that’s left to do is to make the function that will step through all the parts of the recipe document and render the document…


  def create_pdf(which):
    recipetitle = recipe_table_dat[which][1]
    recipeid = recipe_table_dat[which][0]
    f = Template(format="Letter", elements=elements, title="Recipe Printout")
    f.add_page()



  So the function definition accepts a parameter called “which”. This will be the index of the recipe within the “database”. We pull the recipe title and the recipe id into separate variables, not only for use now, but also later on. Then we instantiate the template object, defining the title of the document, the format of the printout, and the elements. You can also set properties for the document (author, subject, etc) here as well. Finally, we add a page with the add_page() method. Again, fairly close to what we did last month.


  So, to set the various elements in the document, we call the elements that we want to include with, in some cases, a string – one at a time. The format is:


  Object[element] = optional string


  Here is the code for that...


      f["header"] = f"Greg's cookbook - {recipetitle} - Recipe ID {recipeid}"
    f["title"] = recipetitle  # 'Mongolian Beef and Spring Onions'
    f["recipeimage"] = images_table_dat[which][2]
    f["description"] = recipe_table_dat[which][8]
    f["source"] = recipe_table_dat[which][2]
    f['servings'] = f'Servings: {recipe_table_dat[which][3]}'
    f['time'] = f'Total Time: {recipe_table_dat[which][4]}'
    f['rating'] = f'Rating: {recipe_table_dat[which][5]}'



  Since there is no straightforward way to handle a list, I stepped through the list of ingredients and created a string, which is then set using the ingredientitems element…


  itms = len(ingredients_table_dat[which])
ings = ''
for itm in range(itms):
    ings = ings + ingredients_table_dat[which][itm][5] + "\n"

f["ingredientshead"]
f["ingredientitems"] = ings
f["instructionhead"]
f["instructions"] = instructions_table_dat[which][2]



  The instructions section is handled the same way.


  Finally, we render the page pretty much as we did last month, but this time, we use the recipe title as the filename for the PDF. After that, we notify the user that the rendering process is complete.


      filename = f'./{recipetitle}.pdf'
    f.render(filename)
    print(f'\n\n{"=" * 45}')
    print('        PDF has been generated')
    print('     Please open the PDF manually')
    print('=' * 45)
    print('\n\n')



  Lastly, I needed a way for the program to prompt the user to select which recipe to use. I created a simple CLI based menu.


  def menu():
    print('Please select a recipe...')
    print('1 - Mongolian Beef and Spring Onions')
    print('2 - Amish White Bread')
    print('3 - "Crack" Chicken')
    resp = input('Please enter 1, 2, 3 or 0 to quit --> ')
    if resp == "0":
        print('Exiting program!')
        sys.exit(0)
    elif resp in ("1", "2", "3"):
        return resp
    else:
        return -1



  And a routine that loops and does the menu until the user uses “0” to quit...


  def mainroutine():
    loop = True
    while loop:
        resp = menu()
        if resp == -1:
            print('Invalid selection.  Please try again')
        else:
            print(f'Requested recipe: {resp} \n')
            create_pdf(int(resp) - 1)



  Well, that’s it. I believe that, as a quick PDF generator that can be controlled easily from Python, pyFPDF is a good tool. However, as a template engine, I’m not convinced that it will work in the real world. Given the fact that the latest code changes were done 3 years ago, I don’t hold out much hope that the author will address the many issues surrounding the template engine. There is a big part of me that wants to fork the project and modify the code myself, but life and time and work (as always) prevent me from doing it right now. Just one more item on the todo list.


  Normally, I would post the project code, when the project is more than working directly within the Python shell. This month, I am going to break tradition and not post it on Pastebin.com. The reason for this is that I don’t believe that pastebin will allow me to post the image files for the recipes. This is also one of the reasons that I didn’t just directly work from the recipe database, which at the moment, holds over 300 recipes, and for each recipe there is an image. So, I’ve created a repository on Github to hold this month’s project. By doing it this way, all you have to do is follow the link to the repository, download the project as a zip file (you could clone it, but that is, in my mind, a lot of wasted effort on your part), unzip the folder somewhere convenient for you, and run the python program, called template1.py. The link to the repository is https://github.com/gregwa1953/FCM160. One other benefit is that if something happens and I lose a domain (as has happened in the past), this will last forever or until github dies. Given the amount of code on github, I REALLY doubt that will happen.


  One more bit of news before I leave you for this month. As of Wednesday, August 5, I have signed a contract to write another book. This one will be about learning to use PAGE to create GUIs for Python. I’ve written a few articles about PAGE in the past, and I’m sure that I will in the future as well. The working title, at the moment, is ‘Learning Page A GUI Designer for Python’ and I’m estimating that it will be published sometime in January 2021.


  So as always, until next time; stay safe, healthy, positive and creative! Greg


  
    Greg Walters is a retired programmer living in Central Texas, USA. He has been a programmer since 1972 and, in his spare time, he is an author, amateur photographer, luthier, fair musician and a pretty darn good cook. He still is the owner of RainyDaySolutions, a consulting company, and he spends most of his time writing articles for FCM and tutorials. His website is www.thedesignatedgeek.xyz.
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  HowTo - Podcast Production in Linux part 2


  Written by Tony Hughes


  In the first article in this series, I talked about the hardware you will need to start to record your podcast and for later post production of your Audio. In this article, we will look at some of the software for recording and editing your audio content.


  If you use a standalone audio recording device, such as the Zoom H2 recorder I mentioned in the first article, you will be ready to go, as far as recording goes; as all the software needed to do this is embedded into the device. The device will have options as to the file format you wish to record in, such as .wav or .Mp3, and some recorders may be able to record in .ogg or .flac formats.


  Depending on your needs and the amount of post production you are planning, then .wav or .Flac will give the best high-quality lossless audio where the audio file retains as much of the audio detail as was picked up during recording without loss of quality. The .wav format is the standard CD audio format, and will take up the most file space, typically around 8.7MB per minute of audio, whereas for a .Flac file, at full quality, is typically around 5MB per minute. If you have limited storage space on your recording device, you may wish to record in .Mp3, which, at standard quality of 128kbits per second, will generate a file of about 1MB per minute of audio recorded (or transcoded from one of the other formats). But, apart from the decisions you need to consider regarding file formats when recording your audio, with a standalone device like the Zoom H2 you are good to go. Put a set of batteries in the device and read the Manual so you know the way it operates and start to record.
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  If you plan to record your audio on a mobile phone, then obviously you will need a recording application for this. As I don’t use an iPhone, I can’t comment on their software for this job, but there is a list of recommended apps here. And I’m sure it will have a voice recording app by default and this may be good enough.


  Android has numerous applications in the Play store for audio recording. A couple that get fairly good reviews are:


  
    	‘Easy Voice Recorder’ which has both a free (with Ads) and paid version, and can record to several different audio file formats.


    	The other is simply called ‘Voice Recorder’ and again comes as a ‘Free’ with ads version and an ad-free paid version.


    	A full list of some of the other options are here.

  


  Remember that, as with many Android apps, you will want to check out what the app wants access to on the phone when you consider if you want to install it to your device. I’m not sure how much of an issue this is with Apple devices.


  You may just want to experiment with the default option on your device and stick with that if you feel it is adequate, but there are a number of applications that can record audio on your mobile device, be it an Android or iOS device.


  If you will be recording on a Desktop or laptop PC, then your options in Linux are very good indeed. A quick search of the web comes up with many lists but the most common used by most in the Linux community, and I include myself in that, is Audacity – which is top of the list. Ronnie did a great Basics of Audacity tutorial in FCM#109, which is a great place to start with this powerful audio editing tool. Another good choice is Ardour although I have not personally used it. I know several people who have more professional audio editing experience than myself, and who feel this is a more complete solution if you have more professional recording editing and mixing needs, but it is not going to be as user-friendly to someone starting to get to grips with the basics of audio editing as Audacity. My recommendation would be to start with Audacity as there are lots of tutorials on the web to get you started, and the basics are fairly easy to master.


  We started this by looking at software for recording, but you will also need software to edit your audio if you are going to do anything to it before you post it to the internet in your chosen way.


  If you are using an Android device, and I would not recommend a phone for this, but with a 10”+ tablet it is probably possible. There are a number of applications that can edit your audio once recorded, although as I have not tried this method and this is about using Linux to start your podcasting journey, all I’ll say is that this is a link to 8 such programs (https://techwiser.com/audio-editing-apps-for-android/).


  As for using Linux for editing, the list above (which I suggested as solutions for recording audio) also work for editing. Again my suggestion for the beginner would be to start with Audacity, and, as you get more confident and your needs become more complex, you may wish to check out Ardour or one of the other more task-specific programs that may have the more complex functionality you may need.


  If you are recording a solo podcast then the above is all the software you may need, but if, like myself, you have decided to jump into the world of recording with more than one person, and you are not all able to be in the same room, town, or even continent, at the same time, then you will need some software that will enable you to talk to each other and record at the same time.
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  There are a number of solutions for this in Linux, but the two that spring to mind, and that I have used, are Skype and Mumble.


  
    	Skype, while not being open source, if there are only a few of you, might be your simple option as you do not have to have a server set up to do this – the infrastructure is provided by Microsoft.


    	Mumble however, while it is open source software, will require the setting up of a Mumble server which can be hosted either in the cloud or on a local server, and if you do not have the ability to do this by yourself or have access to someone else's server, it might not initially be a solution you can use. Although if you are recording content for a podcast that already has a server set up, such as Hacker Public Radio, and you ask nicely, then they may allow you to use theirs when it’s not in use.

  


  There is also the ability to record the conversation on Skype and Mumble, but it is also advisable for each of the participants to record their audio locally as well. This is for two reasons: first you will have a better quality of final edit using the local recordings and mixing them together in post production than the server audio, but you can then use the Skype/Mumble recording as your backup solution if, for any reason, things go wrong with any of the local recordings. I‘m not sure about Skype, but Mumble allows the recording of separate tracks for those on the call, so you can use the audio track for whoever's local audio went wrong, and not the whole of the recording from the call stream, if needed.


  So in these last two articles, we have looked at the hardware and software you will need to get started in the podcast world. In the next episode, I will look at your options for getting your audio out to the listening public, and how to go about this.
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  How-To - Rawtherapee - Part 6


  Written by Erik


  Website: https://rawtherapee.com/


  Version 5.8 Price: Free!


  The skeleton coast is a great place to take photographs in... if you are there at the right time and the right spot. If you are not lucky enough to live close by, and end up with a photo opportunity at the wrong time of day, we can help. We aren’t all sponsored by the BBC to wait around for that perfect day. The skeleton coast has some great contrasts, which make it an attractive destination for photographers. Have you ever wondered about those amazing photographs you see in travel magazines? Well, lets “magazine-worthy” our kitsch photograph. :) Like the tree in the lake in New Zealand, the dead trees in Sossusvlei dooievlei are photographed to death. Don’t believe me? Look for the images in your favourite browser.
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  Our challenge is to get our image to the same quality as these professional photographs. However, our picture is rather “flat”. This is due to the bright sun in the summer, when you pray for a cloud … aaand obviously taking it at the wrong time of day, but we won’t go there. It’s time for super open-source software to the rescue. Just so you know, there are no monthly / yearly license fees either!


  Now if we look at some of these examples I have in my search, you will see that the sky looks unnatural. We don’t want that. That is obviously something like an auto edit or a really bad hand edit. The same with the pictures where the sky and the dune join to make a lighter color...
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  Our picture is all faded colors, so one would think that is where you should start. There is a reason exposure is the first tab. It is meant to be your first stop. Our histogram gives us a clue, leaning toward the right. We also have some null space on the left, meaning we can play with the shadows as well. Just by sticking to basic editing, no advance nothing, we can immediately improve the look and feel of our shot. We drop our exposure into the negatives and play with contrast and saturation. Until our picture is life-like. Our histogram should separate nicely into red / green / blue (ignoring the outlier) and settle in the middle, whilst the darker tones sort themselves out as the histogram centres.


  The TL;DR version is: don’t overthink it. You don’t keep searching for your car keys once you have found them.


  One can see that the makers of this awesome open-source editor thought about how a photo gets edited, before putting the interface together. You do not need to be a master if things are logical and straightforward, just like you do not need to be a chef to bake a bread if you have a recipe and a method. Experience will take you the other half of the way.


  You may want to add some highlights, but try to stick to: less is more. So let’s move to detail. Just turning on sharpenc, did the trick for me, though I will refer back to it once I turn on and check my local contrast. Again, just turning on local contrast did the trick. Let’s face it, there isn’t much going on in this picture, so when the dead tree popped, I stopped. Poetic, I know ...


  Moving on to color. We have a lot of color noise. The reason is because of the time period this picture was taken in. Space was at a premium and a 2GB SD card cost the same as a 64GB card costs today, so raw was not an option. The jpeg algorithm back then was also not as efficient as it is now, neither were the image processors. We have already discussed how to deal with color noise, so I will not repeat it.


  Since there is not much I can do about the colors here, I head straight for vibrance. Step up the pastel tones, but don’t overdo it. Instead of grabbing and moving the slider , use the + button. Slowly tease the life out of the photograph. The blue sky may hint towards the unnatural, but we will look at correcting that in another tutorial. :)
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  You can now jump to transform and select your lens correction. Since this was an older camera, my lens was listed, but if yours is not listed, you can import your LCP file. Full instructions here: https://rawpedia.rawtherapee.com/How_to_get_LCP_and_DCP_profiles


  So now we have vibrant color, we have sharpened the image, and we have our highlights and shadows sorted. However if we look at the sand, we notice that this is not Arrakis, there is detail in the dune. We want to draw attention to it, making it stand out more, making our image more “real”. Head back to exposure ( you have now gone full circle *wink.), and turn on tone mapping. You *may see something happen. We are going to adjust only the edge stopping feature. Move the slider up until the marks in the dune start to pop. Zoomed in all the way, you want to see the pock marks, the stones, and the weeds. The compromise you must make is near and far. Remember to check the ground nearest to you and the ground furthest away from you, and get that detail balance. If you have never been, to give you an idea, that is a group of people on the dune in the background.


  We can now save our editing profile in the top right and apply it to the next image taken in the same region, helping us speed along our workflow.


  
    Tip: work in small increments if you want your images to remain “natural”, take giant leaps if you want shock and awe art pieces.
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  Our final image is right up there with the shots proudly displayed on the internet, and we did not have to hang around for the ‘perfect’ opportunity.


  I hope you had fun if you followed along and I hope you learned something.


  Disclaimer: In no way am I an expert in photo manipulation, I just know a guy who had a dog that gave me some fleas. I thought I may help you scratch an itch also.


  As always, if you have any questions or comments, send them to: misc@fullcirclemagazine.org


  
    Erik has been in IT for 30+ years. He has seen technology come and go. From repairing washing machine sized hard drives with multimeters and oscilloscopes, laying cable, to scaling 3G towers, he's done it.
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  How To - Drawing with Inkscape - Part 100


  Written by Mark Crutch


  Amazingly, this is the centenary article in this series! That’s not bad given that my original plan was for maybe half a dozen short pieces as a brief introduction to Inkscape. I doubt there are many people who have read all of the articles, but even if you just dropped into one or two as reference material for a specific feature, I hope you’ve found them useful. This month, I’ll be continuing to look at Inkscape v1.0. Although there are a lot of exciting new things to cover – and I promise to get to them in the coming months – for now I’m going to return my focus to some of the problems that have found their way into the new release. It’s not that I want to be a pessimist, I’d just prefer to get the issues out of the way as quickly as I can.


  The regressions that most users are likely to stumble across are largely related to path operations on text objects. Manipulating text to produce a graphical effect is a common task for Inkscape users, when creating a logo or just trying to make the text on an image look more interesting. There’s little you can do with a pure text object, apart from the usual rotate, scale and skew. Filters can produce some amazing results – whilst still keeping the text editable – but are difficult to work with, and are best used to provide texture or shadows rather than for fundamentally changing the letter shapes. At some point in your graphical adventures, you’re bound to find yourself converting text to a path in order to manipulate it further.


  Converting Text to a Path


  Logos and styled text form the basis of a huge number of Inkscape tutorials, almost all of which require the user to convert their text to a path at some point, via the Path > Object to Path menu option. Depending on the age of the tutorial, and the version of Inkscape it targets, this can lead to very different outcomes.


  For most elements in Inkscape the result of Object to Path has always remained the same. A rectangle becomes a path. An ellipse becomes a path. Spirals and polygons become paths. It may sound obvious, but in most cases the Object to Path feature turns your object into a path. With older versions of Inkscape (prior to 0.48) the same was true of text objects: the entire text would be converted into a single complex path. Most tutorials deal with applying an effect or style to the entire text, so creating a single path is just what is wanted. But sometimes you need to be able to work with the individual letters. Splitting the complex path into separate letters is a fiddly task that requires some experience to do easily. So, with 0.48, the developers changed the Object to Path behaviour when applied to text elements: to this day it creates a group of paths, one for each letter.


  This change in behaviour immediately made a lot of tutorials slightly obsolete, and led to a persistent trickle of new users to Inkscape support sites posting requests along the lines of “I’m following this tutorial on YouTube and I get as far as converting my text to a path, then the next step doesn’t work…”. In case you were in any doubt about the longevity of content on the internet, the trickle of users following tutorials written for 0.46 and earlier continues to this day.


  The ‘obvious’ solution to this change is to ungroup the converted text, then join the paths together using Path > Union or Path > Combine. But whether by accident or design, the developers did leave a shortcut in place that allowed for a one-step conversion of text to a single complex path. Rather than use Object to Path, selecting the text object and going straight to Path > Union would have the desired effect. This quickly became the common response to new users following older tutorials, and also became a prominent method in newer tutorials. It’s worth noting that Path > Combine, when applied to a text object, also created a single path but it still puts it inside a group, which is arguably a little useless. Nevertheless, for 0.48 and 0.92 there are four ways to convert text to one or more paths.


  
    
      
        	
          Method
        

        	
          Result (0.48 and 0.92)
        
      

    

    
      
        	
          Path > Object to Path
        

        	
          A group containing one path per letter.
        
      


      
        	
          Path > Combine
        

        	
          A group containing a single complex path for the whole text.
        
      


      
        	
          Path > Union
        

        	
          A single complex path for the whole text.
        
      


      
        	
          Path > Object to Path, then Ungroup, then Combine or Union
        

        	
          A single complex path for the whole text.
        
      

    
  


  Unfortunately, Inkscape 1.0 removes the Path > Union shortcut. To make matters worse, the status bar shows an “error” stating that “one of the objects is not a path, cannot perform boolean operation”, even though it does convert the text to paths, albeit in the same way as the Object to Path option.


  
    
      
        	
          Method
        

        	
          Result (1.0)
        
      

    

    
      
        	
          Path > Object to Path
        

        	
          A group containing one path per letter.
        
      


      
        	
          Path > Combine
        

        	
          A group containing a single complex path for the whole text.
        
      


      
        	
          Path > Union
        

        	
          An apparent error message in the status bar, but it still converts the text to a group containing one path per letter.
        
      


      
        	
          Path > Object to Path, then Ungroup, then Combine or Union
        

        	
          A single complex path for the whole text.
        
      

    
  


  So now there’s a resurgent flow of new users to support sites who are finding that tutorials for 0.48 or 0.92 are also incorrect with the new version. But as there’s no longer a one-step solution to this task, the answer is usually to use the three-step approach.
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  Inset and Outset


  Related problems appear when using Path > Inset and Path > Outset. In both these cases, Inkscape 0.92 and earlier handled text objects as a special case: the text would automatically be converted to a single path for you before the effect was applied. But with 1.0, the results are not only not what you might expect, but the UI is downright misleading!


  With your text object selected, choosing one of these options might be expected to make it thinner (Inset) or thicker (Outset). Earlier versions did this, via the implicit conversion to a path, so although there were some users who were surprised that their text was no longer editable as a text object, for most the experience was in line with expectations. Try the same with 1.0, however, and the status bar says “No paths to inset/outset in the selection”. What it doesn’t immediately make clear, however, is that rather than failing benignly, leaving your text object untouched, it has also converted your text to a group of paths! So not only does it fail to do what you originally wanted, but it’s changed the nature of your object in the process.


  Initially it might seem that the quick solution is to apply the inset or outset effect twice: the first converts the text to a group of paths, and the second then applies the desired effect to those paths. But alas, the first operation leaves the group itself selected, not the paths, and applying inset/outset to a group doesn’t work, even if that group consists of nothing but paths. Instead, the best solution is to perform the three-step conversion above to convert the text to a single path, and only then apply the inset/outset operation.


  Dynamic Offset


  The Path > Dynamic offset operation seems to be particularly misleading when applied to text in version 1.0. In older releases, the behaviour was similar to inset/outset: there would be an implicit conversion to a single path before the real operation was applied. In this case, the operation results in a small diamond-shaped handle that can be dragged to dynamically adjust the inset or outset amount.


  Not so in 1.0. Initially, there’s no visible change, except that the selection box has lost its handles, and the pointer looks different. That’s actually because Inkscape has switched you to the Node tool. The usually helpful status bar is now positively misleading. “Drag to select objects to edit”, it begins. So you try dragging across the whole text: no change. You drag over a few of the letters: now the selection box disappears completely. “… click to edit this object”, it continues. So you click on a letter, and are presented with the node handles for the path making up that one letter. Because, yet again, when you first clicked the Dynamic Offset menu entry, your text object was converted into a group of paths, one per letter. You can click on other letters, and in each case the previous one is de-selected, and the clicked one shows its nodes. Shift-clicking selects multiple letters. You can drag the nodes, add them, delete them, and generally work with the Node tool as usual. But there’s no handle presented for dynamically adjusting the inset/outset which was, after all, what you were trying to do in the first place.


  As with inset/outset, the dynamic offset effect doesn’t work when applied to a group of paths. Unlike those operations, however, it also won’t work when applied to a selection of several paths – instead dropping you into the Node tool, even on earlier Inkscape releases. This means that there are no shortcuts: you simply can’t avoid converting your text to a single path if you want to use the dynamic offset feature on it. It’s back to performing the three-step conversion process first.


  ​ Linked Offset


  The last command in this group, Path > Linked Offset, also fails to work with text in 1.0, but this time the workaround is quite different – it’s more complex, but does at least provide some useful functionality in the process. Let’s have a quick refresher on linked offsets in 0.92, and why I think they’re usually a better option than inset/outset or dynamic offsets when working with text.


  If you look at the SVG output for each of these commands, you’ll start to understand the differences between them. Inset and outset simply create a new path element that replaces your original object entirely. There’s no trace of it left in the file. They’re useful when you just want to make another path element a bit fatter or thinner, and don’t need to retain the original path in any way. Viewed in this way, you can understand why text (or any other shape) has to be converted to a path for these operations to work.


  Dynamic offset is a little different. Yet again a path is created, completely replacing the original object. Like all SVG paths, it contains a “d” attribute which holds the details of the path shape, so that other programs can display it correctly. But this path has some additional Inkscape-specific attributes that are not usually present on a path. The first is “sodipodi:type” with a value of “inkscape:offset”, indicating to Inkscape that this path should be treated differently to normal paths.


  The second special attribute is “inkscape:original” which holds a copy of the original path that was used to create this offset path. Although the original path has been removed from the drawing, it lives on in this attribute, the content of which can even be copy-pasted into another path object to reconstruct the original shape. The third attribute, “inkscape:radius”, holds the size of the offset – i.e. how far you have moved the handle from its original position.


  When a path has these attributes set, Inkscape no longer uses the “d” attribute to draw the path. Instead it calculates the new shape based on the original path and the radius (offset) value. Change either of these and you’ll see that Inkscape updates the “d” attribute automatically, but this is just so that the shape appears correctly in other software.


  A linked offset also creates a path, but leaves the original object untouched. This path is similar to the dynamic offset case, but adds one more special attribute into the mix, in the form of “inkscape:href”. This holds a reference to the original, untouched object.


  The new path still contains a “d” attribute, for other software to use. But it also still contains an “inkscape:original” attribute, again holding a path shape. This time, however, the path data here is created by implicitly converting the source object (the one pointed to by inkscape:href) into a path. If you change the source object, Inkscape updates the “inkscape:original” value which, in turn, results in an update to the “d” value.


  What does that mean in practice? It means that your original object retains its original type. Stars are still stars, and can be edited with the appropriate tool. Spirals and rectangles, again, are left untouched and can still be edited with their own tools. And yes, text is also left as text, meaning that you can change the font, style and even the content, with the linked offset updating automatically. This alone makes it the best option for offsetting text. You can hide the original or place it off the page if you want, but when you later discover a typo, or need to edit the words, you can make those changes to the original text and know that your offset version will stay in sync.


  But not in Inkscape version 1.0.


  Yet again in this version trying to use the command just converts the text to a group of paths and switches you to the node tool. You can use the three-step conversion to create a path before you select the menu entry – but that completely defeats the point of using a linked offset rather than a dynamic offset.


  Luckily the underlying rendering engine isn’t broken. If you present it with a linked offset created in an older version of Inkscape it displays correctly, and the original object still retains its original type and editability. Fortunately, we can reproduce this behaviour entirely in 1.0, but it does involve some use of the XML editor. These are the steps you’ll need to follow:


  
    	Select your text object and open the Object Properties dialog via the context menu, or the Ctrl-Shift-O shortcut.


    	Copy the ID from the dialog to the clipboard. Close the dialog.


    	Create a temporary object. Just about any sort will do, but I usually use a rectangle or ellipse. Making it a distinct color will help to keep track of things later.


    	Apply the Path > Linked Offset function to the temporary object.


    	With the linked offset selected, open the Edit > XML Editor dialog.


    	The linked offset should already be selected in the editor. You should see the extra attributes I described previously.


    	Change the inkscape:href attribute: delete most of the content, but leave the “#” in place, then paste the ID from the clipboard immediately after it.


    	Press Enter to make the change. You should see your text apparently change to the color of the temporary object. What you’re actually seeing is the linked offset positioned on top of your original text.


    	The Inkscape UI is a little confused at this point, as the temporary object will still be showing the linked offset handle. Switch to the Selection tool to get things back under control.


    	Delete the temporary object.


    	Double-click on the linked offset text, or select it and switch to the Node tool and you should see the usual offset handle. Adjust this to change your offset amount.

  


  It seems like a lot of steps, but all we really did was create a linked offset to another object, then adjusted the link to point to our text object instead. Most importantly, our text remains untouched, so can still be edited using the normal text tools, with the linked offset updating automatically.


  One final thing to note is that the steps above also work for other shapes. If you want your rectangles to remain as rectangles, or your stars to still be editable with the star tool, you’ll need to follow those steps to avoid Inkscape 1.0 automatically converting your source objects into paths.


  
    [image: ink2]
  


  ​ Reversing Sub-paths


  I mentioned this issue back in part 95, when Inkscape 1.0 was still in Beta. Unfortunately the final release still suffers from the same problem.


  With older versions, if you have a complex path (i.e. one with sub-paths), you could select a single node in the sub-path, then use Path > Reverse to reverse just that sub-path. This can be invaluable when working with the nonzero fill-rule, as described in part 95. In Inkscape v1.0 the Path > Reverse option reverses every sub-path, regardless of what was selected.


  There is only one way to work around this issue, and it’s something of a pain on more complex designs. You have to use Path > Break Apart, then reverse the sub-path in question, then select all the constituent paths before using Path > Combine to put them back together into a single complex path.


  Final Thoughts


  I hadn’t really planned to celebrate 100 articles with a text-heavy trawl through bugs and a deep dive into offsets, but these are the sort of problems that will affect lots of users, so warranted spending some time on. It just goes to show that new isn’t always better, and makes a strong case for sticking with 0.92 for the time being, especially if you’re a new user following some online tutorials.


  All these problems have been reported, and I have added extra comments or information on the bug reports where necessary. Hopefully the next release will address some of these issues – many of which look as though they have a common underlying cause.


  Next month I’ll move back onto some of the good stuff in Inkscape 1.0, hopefully without bumping into any more serious bugs along the way.


  Mark uses Inkscape to create three webcomics, 'The Greys', 'Monsters, Inked' and 'Elvie', which can all be found at http://www.peppertop.com/


  
    Mark uses Inkscape to create three webcomics, ‘The Greys’, ‘Monsters, Inked’ and ‘Elvie’, which can all be found at http://www.peppertop.com/
  


  


  
    [image: Contents]
  


  Using Krita to Rework Old Photos - Part 10: Going Digital, part II


  Written by Alan Ward


  This series is aimed at learning to make something of the old photos in my possession and others in the public domain, due to their age. You, the reader, are welcome to tag along and, I hope, glean some small insight and perhaps an idea or two from time to time. No promises are made as to the quality of the content, or potential errors and omissions. I am a computer scientist, not a true artist or a professional in image restoration. So please take all this as a best effort, but with no firm guarantees — much as is the case of most open-source software.


  In the previous part of this series, we took a look at an interior photo which exhibited the typical lack of sensitivity of early digital cameras’ sensor chips. In this part, we will work on the opposite defect: washed-out colors due to too much light in the original scene for the camera to handle. This is typical in outdoor shots where plenty of sunlight has illuminated the scene. Contrary to popular belief, the problem may actually become worse in slightly overcast or hazy conditions, where a lot of reverberation tended to overload early light sensors. This was the case in the following scene from the island of Cheung Chau in Hong Kong.
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  There is clearly enough light here to take a clear picture, since even the shadows under the tree branches hold enough detail. However, the sensor was unable to handle the sunlight bouncing off the white buildings in the background, the illuminated part of the tree trunk, or bicycles’ chrome handlebars. But, is this excessive light the case for all primary colors? The Histogram window (at menu Settings > Dockers > Histogram) gives us a more complete story:
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  Going from left to right, in the first place we see that very dark pixels at the far left of the histogram are few, though among these there is a tendency to contain a blue tinge and a defect of cyan. There is, in fact, a large proportion of pixels that have intensities in the middle range, with some reddish tinge to them. There is also a distinct lack of light-colored pixels in the middle of the top quarter to the right of the histogram, and these have a magenta tinge to them. Finally, there is a very heavy group of very light (whitish) pixels to the extreme right of the graphic.


  Thus, from a standpoint of light exposure, what we have seen in the histogram shows us that the image is in fact globally rather well-balanced, except for the very light pixels. This tells us more about how the (old) digital camera’s chip reacted to light in the first place. Its response was correct for low and medium levels of incident light, but exaggerated for higher levels, which leads us to deduce a lack of calibration of the software that translated electrical signals into colors levels in the controlling software.


  On the other hand, there seems to be some relationship between color balance, and pixel intensity value. Let us examine this further. The Layers Docker that is usually found in the lower right-hand corner of Krita’s window has a second tab, Channels. Using this tab, we can activate or deactivate at will any or all of the main Red, Green, Blue and Alpha (transparency) channels in our image, without actually making any changes to pixel values.
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  After some tests, it becomes clear that all channels have, in fact, lost a lot of detail in the lighter pixels. Of the three main colors, Red is the channel that holds more information of the darker colors -- and, thus, it is the channel that represents better the details in the shady part of the tree. In other words, the chip inside the camera seems to have been more sensitive to red light than blue or green, especially at higher intensities.


  At this point, we can take our handling of the image in several different directions. The first would be to try to balance intensities on a channel-by-channel basis. In Filter, Adjust and Color-adjustment curves, I started by giving the general luminosity response a slight tweak in the middle of the higher quarter of the scale. What I am doing is counteracting the corresponding peak at the rightmost end of the histogram, and trying to eek out some more detail from the washed-out whites. This is clearly not working.
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  A very slight increase in the details of buildings at the back of the image is achieved, but at the expense of rather weird-looking colors, for instance in the greenish pane windows to the left. Could I get better results by working on a single channel? As before, I went into the Color adjustment curves window, and now tried adjusting each channel individually. The end result is the very same: details are not forthcoming. It is in fact clear that a large quantity of information has simply been lost inside the lighter parts of the image. Whichever way we go about it, once lost, this information cannot be retrieved since it is no longer within the image.


  So, what can be done? An alternative approach is to step back and think about what we have been doing. The main center of our interest in this image is clearly the tree itself, and the heap of bicycles parked around it. The buildings in the background are less noteworthy, and give very little to the complete message. So, what if we exaggerated the process, and blanked out the burned whitish buildings altogether? We could thus concentrate on the photo’s main subject, with fewer distractions.


  We can do this either in color, or in black-and-white. When we examined the image’s color channels previously, the red channel actually had quite a nice vibe to it. So I went back into the channels part of the Layer docker, and turned off both the blue and green channels. I then went back into Layers, and added a new transparency layer. Then, using the airbrush at low opacity (about 30 to 50%) and some pure white, I scrubbed out selectively parts of the buildings in the background, concentrating on their darker elements that stood out more such as window frames. Other vegetation such as some palm trees in the background were also cleared up. The end result allows the main subject to stand out from its surroundings, and the eye can concentrate on the details that struck the photographer’s imagination when taking the photo more than a decade back.
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  In this part of the series, we examined the effects of excessive light on one of the first digital cameras, seeing how very light colors got easily washed out. Since much information on details has not been retained within the image file, it is now impossible or very difficult to put it back into the image through color curve manipulation. Thus, it may be advantageous to proceed otherwise, thinking more about the global effect that is required and trying to use the burned-off parts of the original photo to our advantage. In the next part of the series, we will work on another early digital photo, in which the camera’s optics and light-sensitive chip lost some definition in an otherwise quite pleasing scene, due to their lack of resolution at the time. Until then, take care!


  
    Alan holds a PhD in Information and the Knowledge Society. He teaches engineering at Escola Andorrana de Batxillerat (high-school). He has previously given GNU/Linux courses at the University of Andorra and taught GNU/Linux systems administration at the Open University of Catalonia (UOC).
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  Linux Loopback - OpenZFS


  Written by S. J. Webb


  There are numerous non-profits in free software. Some of them we know by heart, such as the Free Software Foundation. When I was reviewing the OpenZFS Foundation, I came across another foundation named Software in the Public Interest. Interesting enough the Debian Project created the Software in the Public Interest, after the Free Software Foundation stopped supporting it. This non-profit started in New York, United States of America in the year of 1997. Their mission is to overtake the non-technical, legal aspects of important projects.


  
    [image: loop1]
  


  There are currently 40 projects sponsored by Software in the Public Interest. Some of these projects range from games to Arch based distros. In order for a project to be sponsored, it has to be approved by the Foundation’s Board. The projects can be hardware or software in nature, as long as it follows the open source mantra. The major work stream is holding or distributing funds, holding substantial funds, holding intangible assets, signing contracts, legal assistance, and technical services. If there is a special request above their standard service, the board might review it to see how reasonable it is.


  Membership to Software in the Public Interest offers two membership levels: contributing and non-contributing. The non-contributing members are those that live in the spirit of using free and open software. Contributing members are defined as those who actively participate in the free and open software. In other words, typically users of Linux qualify as the non-contributing members.


  It is interesting to see the dedicated purpose of helping software developers with the non-coding side to open software projects. I just wonder how many projects would still be operating if they utilized these services.


  Until next month...I still have to find a topic for next month.


  
    S. J. Webb is a researcher coordinator. When he is not working, he enjoys time with his wife and kids. He thanks Mike Ferarri for his mentorship
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  Everyday Ubuntu - Making the GNOME Desktop Useful


  Written by Richard Adams


  One of the things that I see praised in regards to the GNOME Desktop is how ‘clean’ it is. I personally have always regarded it as ‘sparse’, since the first time I saw it years ago. This may be controversial, but I’ve never been onboard with this ‘clean’ desktop idea, especially not when the operating environment forces it on the end user. The desktop can and should be a very useful part of your computing environment, not just a neat or pretty one.


  Many Linux users come from a background of using the command-line to perform a lot of their everyday tasks, and it’s true that the command-line is easy to access, and that many tasks are very easily done from the CLI, or Command Line Interface. Long time readers (both of you) will be well aware that I often use the command-line ‘apt’ commands to install software and updates, and that I generally prefer them to the GUI (Graphic User Interface) alternatives (parenthetically, I do like the new Ubuntu Software app, it feels like you’re shopping online for software in a well-designed store). I think, sometimes, that if you’re more comfortable on the command-line, you can miss out on how a modern GUI can be used to make your computing life more efficient.


  My thesis, here, is that the desktop can be used as a very useful place to put program shortcuts, and shortcuts to files and file locations. This can be done in an organized and systematic fashion that promotes efficiency while still keeping the desktop relatively ‘clean’. However, ‘out of the box’ GNOME stymies that by not ALLOWING you to put shortcuts on the desktop, which I find absolutely inexplicable and extremely frustrating. The most superficial consideration of the issue inevitably leads to the conclusion that it should be a matter of CHOICE, not a mandate, as to what you can or cannot reasonably put on your desktop. It is, after all, YOUR desktop, and should work how YOU want it to.


  To summarize, I personally don’t want to constantly have to sort through the applications I use from the ‘Show Applications’ drawer (that’s the unmoving set of white squares at the bottom of the Favorites launcher): [image: every1] nor is there adequate room on GNOME’s Favorites launcher for the applications I use most often (as described in Everyday Ubuntu: Full Circle issue 158, page 41). I want to put things on my desktop in order to access them more efficiently, and I regard that as more important than the aesthetic appeal of a ‘clean’ desktop. But, how do we address this GNOME deficiency?


  Here’s the standard GNOME desktop as it appears ‘out of the box’:


  
    [image: every2]
  


  As you can see, there are icons on the desktop that represent your Home location, and the Trash, but nothing more. You cannot drag application icons from Show Applications to the desktop, as you can from Unity’s Dash.


  Installing GNOME Tweaks


  We’re going to need to install additional software to get where we want to go. If you didn’t set up a Terminal icon on the Favorites before (again, Full Circle issue 158, page 41), then we’ll need to invoke the Terminal the ‘hard way’. At the top of the screen, click on Activities: [image: every3]


  In the box that says ‘Type to Search’, type in term. This should be sufficient to bring up the Terminal icon. Click to launch the Terminal.


  The additional software that we need is GNOME Tweaks. To install it, we’re going to use the apt-get command in the Terminal. At the Terminal prompt, type in


  sudo apt-get install gnome-tweaks



  then hit <Enter> on your keyboard. Note you will need to be on the Internet to download and install the software. Respond to any prompts, including the request for your administrator password that you established when setting up Ubuntu. The ‘sudo’ part of the command is short for Super User DO, and tells the operating system that the following command is being executed as an administrator, or Super User, which is why Ubuntu asked for your password. Software installation and updating in Ubuntu can be done only by an administrator, or super user.


  Shortly, apt-get will complete the installation of GNOME Tweaks and will give you a message in the Terminal indicating that is the case. Now we can add icons to the desktop by invoking Tweaks and enabling desktop icons.


  Click on Activities at the top of the screen: [image: every3]


  In the box that says ‘Type to Search’, type in twea. This should be sufficient to bring up the GNOME Tweaks icon. Left-click to launch Tweaks:


  
    [image: every4]
  


  Click Extensions on the left to get to the desktop icon area:


  
    [image: every5]
  


  You can now click the slider on the right to turn Desktop Icons on. You can also click the gear icon next to the slider to get options regarding your desktop icons:


  
    [image: every6]
  


  Adding a Desktop Icon/Shortcut to the Desktop Using GNOME Tweaks


  Now comes the unfortunately very non-intuitive and still awkward part of the process. We need to find the ‘.desktop’ files for any applications we want to add to the desktop, and there are multiple possible locations where these might be installed.


  First, launch your file browser. This will be an icon on the Favorites launcher that looks like a file folder: [image: every7]


  Once in File Manager:


  
    [image: every8]
  


  click the ‘hamburger’ menu in the upper right (the one that looks like three straight horizontal lines). This will bring up the File Manager’s options:


  
    [image: every9]
  


  If it isn’t already turned on, click the checkbox to Show Hidden Files. Now you’ll see a number of files and folders that start with a ‘.’ - this is how Linux denotes to the operating system that a file or folder should normally remain hidden from view.


  The location of your ‘.desktop’ files will vary according to whether or not your system is set up as a single-user system or has multiple users, and on exactly what version of Ubuntu you are using, and may also vary by application. On a single-user Ubuntu 20 installation, most of them will be found under /usr/share/applications. “What does that mean, and how do I get there?” I hear you ask. Well, we’re going to need to access some of the Linux system files that live outside our home directory, where most of our activity in Linux takes place. Don’t worry, it’s not TOO scary.


  Finding Our .desktop Files


  First, we have to find our way to the system’s root folder. This is not intuitive in Ubuntu, but probably on purpose, as most users never need to navigate there. See the Other Locations on the left hand side of File Manager, at or near the bottom?


  
    [image: every10]
  


  Click that and you’ll see ‘Computer’. This is the system root location. Click Computer on the right side, and you’ll see a series of folders. Look for one that says ‘usr’, then double-click it. In ‘usr’, look for ‘share’ and double-click it. Now double-click ‘applications’. Here you’ll see most, if not all, of your ‘.desktop’ files:


  
    [image: every11]
  


  These files contain information for the applications they represent, that can be used to create your desktop icon. Since I like to play chess, let’s right-click the ‘3dchess.desktop’ file and select ‘Copy’. Now, minimize the File Manager and you should see the desktop, unless you need to minimize other programs. Once the desktop is visible, right-click on it and select ’Paste’. You’ll get the ‘gear icon’ generic looking file, but we want to see the application’s specific icon:


  
    [image: every12]
  


  Now right-click the desktop icon and select ‘Allow Launching’:


  
    [image: every13]
  


  The icon, which was a generic ‘gear’ icon, will now change to reflect the application’s normal default icon and will be launchable. Finally, after all this, we have an icon for 3D Chess on our desktop:


  
    [image: every14]
  


  In terms of keeping our desktop relatively ‘clean’, we also can now create folders on the desktop by right-clicking and selecting ‘New Folder’:


  
    [image: every15]
  


  Use the folders you create as categories (for example, ‘Games’ or ‘Office Applications’, where you can drag and drop your individual application shortcuts:


  
    [image: every16]
  


  and you can also create subfolders within the ‘main’ folders to represent subcategories, and organize your desktop that way. But don’t be afraid to make GNOME’s desktop your own, and make it work in a way that suits YOUR needs.


  
    Richard 'Flash' Adams lives in rural north Alabama and has been a computer support technician, a business analyst, a software salesman, a sales analyst, a QC team lead, and a partridge in a pear tree. His cockatiel, Baby, now has an adopted little brother, a dusky-headed conure named Skittles.
  


  


  
    [image: Contents]
  


  Ubports Devices


  Written by UBports Team
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  My Story


  Written by Moss Bliss


  OK. I'm old. People ask me to tell them about my journey with Linux, but it goes back further than that.


  When I was a Senior in High School (1969), living in the Los Angeles area, we first heard about pocket calculators. We laughed. Who would want to pay $250 for something to help you with basic math? Sure, the idea that computing had come that far was exciting.


  I went to college, Sterling, Kansas. The school had a mid-frame computer, a new thing for them, and was starting a computer science course. The computer was a Buffalo I think, but it may have been a Mohawk, and was running the brand new language, Fortran 70. I was told I did not have sufficient math credits to get in, and the courses I needed to take to catch up were filled with mostly athletes -- a group of individuals who always liked to bully me, and it was no different at this school. But I had a friend in the computer science department, and I got snuck in from time to time to play either of the two computer games on the system -- Star Trek and Hammurabi. I never got to play Star Trek that much, and don't even remember the basic game play.


  My interest in computers continued about the same as my life -- always intrigued, never jumping in with both feet. In 1978, I took a class in BASIC at Alexander City State Junior College, Alex City, Alabama. I completed the first 6 lessons (of 9) with top marks, but lesson 7 required knowledge of trigonometry, of which I had none. Since I was insufferable getting the first 6 lessons done, nobody wanted to help me. I ended the class incomplete, but the professor gave me a C in the class anyhow (my other classes were also incomplete, resulting in an Inc and an F). Part of the reason was being despondent about not being able to finish the BASIC class, part of it was it was too expensive to get to and from school on what I made. I even hitchhiked a number of days when I didn't have gas money, but it got too depressing and I stopped trying.


  Fast forward to when I lived in Denver the second time (1973-1978 was the first time, 1980-1990 the second). I had just gotten some amount of money, don't remember from what, and there was really nothing I had to do with it. While I could have saved it or something, I walked into a store which was selling Texas Instruments TI99/4A computers for $165, including a cassette tape recorder, two game cartridges and two joysticks. While I wasn't really into games, I knew I wanted to be in computers. I got this system... and found the BASIC employed was a bit rough, but I at least managed to recreate some of my better programs in college. But to move forward, I needed to have disk drives. That required the Expansion Box... which was $400, empty – the drives cost extra. I never made it over that hump, and the TI eventually became discarded.


  During this time, I also had a friend who got permission for me to work in her office, Education Commission of the States, and train on the word processor they used, which was NBI. That was a lot of fun, and got me away from using just a typewriter. (My handwriting was so poor that, in 7th grade, my school waived a required course for me to take a semester of Typing. I have been using a keyboard ever since, that would have been 1965).


  In 1986 or 87, I met a woman whom I eventually moved in with and married. She was a QA engineer at Digital Electronics in Colorado Springs. She worked from home at times, so I had access to her VT-102 terminal and 2400 baud modem when she wasn't at home. I would modem into the VAX cluster which she administered ... and play Hack, a variant of Rogue. (I still play Nethack, an updated version). Then I got involved in the BBS world, and a local sysop loaned me an IBM 5150 he wasn't using. (Eventually I purchased it from him). This machine had the famous 8088 processor at 4.77 MHz, had originally come with 256 KB RAM on the motherboard and two full-height 5.25" floppy drives (double density). One of the floppy drives had been replaced with a half-height high density 5.25" floppy drive and a 10 MB hard drive, and there was also a RAM expansion card to improve its memory capacity to 640K (it literally could go up to 720K, but DOS could address only 640K so there were some chip slots left empty). So now I'm running DOS 3.1, and getting heavily into BBSing using Fidonet (I used some Mustang BBSes as well, but didn't like them). I also managed to swap my 10 MB hard drive, along with $100, for a 30 MB hard drive. What would I do with all that space???


  In 1990, I moved to Michigan. At the local library I stumbled upon the 11th Edition of The Secret Guide to Computers (then 3 volumes). I was enthralled, and have nearly every edition they published from the 18th up to about 2015, which is when I noticed that Russ Walter refused to discuss Linux, and so it was no longer of as much value to me. I strongly recommend this book for new users, and you can find most of it for free online at https://secretfun.com.


  It wasn't too long before I needed to upgrade. I found that my 5150 box's 5 expansion slots were already obsolete, as the new computers with 80286s had 8 slots and the new motherboards would not fit into my old box. I managed to get a new box, motherboard, and a few other items, and migrate my cards, drives, and peripherals into the new box. So now I had built my first computer, which was about 1989. I was running DOS 3.3, and had just come upon a DOS extender called 4DOS which was exciting, and was running WordPerfect 5.


  From that time on, I used PC clones. I had to use Windows 2 Runtime at one job, and it really was bad, but better than GEM Desktop. I moved to several other places, and upgraded my computer or bought used ones I could manage to afford. I remember one 386 machine, and a 486 DX/2 I continued to own when I "moved" to Asheville NC in 1998 (crashed my car there, and had no reason to leave, long story).


  This is the time I was getting tired of Windows already, and started looking at Linux. I don't know when I got the Red Hat 5.1 book or the copy of Slackware, but they were too daunting for me to try. I've always been a bit timid, and as I said, I tended to let life happen to me rather than jumping in with both feet. So when I got a copy of Mandrake in 2002, and it loaded on my machine without me entering the serial number of all my internal devices, I mean it JUST LOADED and found everything, I was quite happy. It wasn't good enough to replace Windows for my uses -- I'm just a typical desktop user who mostly did Internet and word processing, not a coder or gamer (I have noted in my life that gamers always have more expensive gear than I can afford). And then I was disappointed when an upgrade of Mandrake would not install on my machine. A short while later, I did find a copy of SuSE Linux (not long before they created openSuSE), and it ran pretty well, but again, it was dual-boot time, not time to throw Windows over the rail just yet.


  In 2006, I was running Asheville Homeless Network, and used some of the funds we raised to get a few Asus EeePCs for the more stalwart members to have so that they could have a better life and an easier time looking for work, These computers had Linux on them, which I insisted on. I'm not sure what I was running at home at the time, but I was probably dual-booting to some version of Linux. We first got the 701 models, and then, when they turned out to be too small for some members, got 901s.


  At some point, I got just so tired of Windows that I went back to Linux. This time I went with Ubuntu. I could use it for everything I needed, so I soon stopped dual-booting. I joined LinuxQuestions 3/14/08 and Ubuntu Forums (with Ubuntu One ) 3/12/08. I was happy until, with 12.04, they moved to Unity Desktop. 12.04 would not install on my computer, and while people kept telling me that there were ways to install 12.04 with a different desktop, nothing I tried worked. So it's back to Windows 7. At this point, I was living in Blaine, TN, the first of 3 addresses there. I moved into Knoxville for a year, and purchased a couple Windows 8 computers, which upgraded to 8.1. I was not happy. When I moved back to Blaine, I had a Windows 7 Dell tower desktop, I don't even remember what happened to those Win8 laptops. And then, Windows prodded and prodded for me to upgrade to Windows 10. I did so. I saw all the security holes people had talked about. I closed all the ones I could, and found there were some which I could not close. I reverted to Windows 7, and found the holes that were opened in Windows 10 were still there. So I got mad. I downloaded Linux Mint 17, and deleted Windows. Forever.


  I've been running Mint since that time, with no Microsoft influences in my life (I changed from Microsoft Office to SoftMaker Office in 2008 while still running Windows, and kept it when I moved to Linux). I was completely impressed with how far Linux had come, with Linux Mint 17, and started looking at other distros to see if they had kept up. I have found that most of them have, and keep hopping in my multibooting life to check them out.


  In August 2018, I heard that mintCast was looking for new hosts. I answered the call, with no prior knowledge of what I was doing, and Rob Watkins accepted my application. Of course, he accepted ALL the applications, and set up online meetings to train the new crew -- whoever could show up got the job. I can't tell you how much more I've learned in my time on mintCast, from our show and from listening to so many other good Linux podcasts. And at some point, I bristled at being called a "dirty distrohopper" and decided to double down. I talked to my mintCast co-host Tony Hughes, and, with his help (couldn't do it without him), started Distrohppers' Digest podcast in April 2019.


  This discourse is void of lots of Real Life Occurrences. I'm on my 6th wife, have a long, fulfilling, and totally unsuccessful music career (CD available at https://mordewis.bandcamp.com ), and have had more addresses than some people have had pairs of shoes. It has been a fun ride with just barely enough success to stay alive. I also have not discussed the myriad of tablets and phones I've had, but we all know that Androidisnot_Linux[TM].


  I hope you've enjoyed this trip down Memory Lane. There are bound to be omissions and inaccuracies in it, my memory is not my best feature.
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  How To - Write For Full Circle Magazine


  Written by Ronnie Tucker


  Guidelines


  The single rule for an article is that it must somehow be linked to Ubuntu or one of its many derivatives—Kubuntu, Xubuntu, Lubuntu, etc.


  The Official Full Circle Style Guide can be read at: http://bit.ly/fcmwriting


  Please read this document before submitting an article. Follow the guidelines and you will have a much better chance of seeing your article in Full Circle.


  Writing


  There is no word limit for articles, but be advised that long articles may be split across several issues. In your article, please indicate where you would like a particular image to be. Please do not use any formatting in your document.


  Images


  Images should be no wider than 800 pixels, in JPG format, and use low compression. When you are ready to submit your article, please email it to: articles@fullcirclemagazine.org


  Non-English Writers


  If your native language is not English, don’t worry. Write your article, and one of the proofreaders will read it for you and correct any grammatical or spelling errors. Not only are you helping the magazine and the community, but we’ll help you with your English!


  FOR REVIEWS:


  Games/Applications When reviewing games/applications, please state clearly:


  
    	title of the game


    	who makes the game


    	is it free, or a paid download?


    	where to get it from (give download/homepage URL)


    	is it Linux native, or did you use Wine?


    	your marks out of five


    	a summary – with positive and negative points

  


  Hardware When reviewing hardware, please state clearly:


  
    	make and model of the hardware


    	what category would you put this hardware into?


    	any glitches that you had while using the hardware?


    	easy to get the hardware working in Linux?


    	did you have to use Windows drivers?


    	marks out of five


    	a summary – with positive and negative points

  


  
    You don’t need to be an expert to write an article –write about the games, applications and hardware that you use every day.
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  Review: GalliumOS 3.1 - A fast and lightweight Linux distro for ChromeOS devices


  Written by Gabriele Tettamanzi


  Back in 2014, I bought an Asus C300, Intel Celeron N2840 2 cores 2.16GHz, 4GB Ram, 32GB internal storage, Bay Trail QUAWKS architecture, running Google ChromeOS.


  After some initial enthusiasm, mainly due to the lightness and the very long battery life, I left it almost unused: even if I added to it some Linux magics by setting up Crouton, actually it was a web browsing system.


  Few months ago, ChromeOS support for this particular model came to an end: it was time to refresh that small rig with a new operating system.


  I decided to eliminate ChromeOS and to install a new operating system, therefore, in order to enable EFI booting and to make the most of the hardware, I removed the write protection screw and I flashed a new firmware by MrChromebox firmware utility script (https://mrchromebox.tech/). By the way, it is worth mentioning that MrChromebox tools are great: the documentation is crystal clear and the pieces of software are working perfectly.


  Afterwards, I tested a number of mainstream distros; however, each and every distro I tested had the very same main issue: internal sound card not working.


  Eventually a web search drew my attention to GalliumOS, the distro specifically dedicated to Chromebooks and Chromebox.


  GalliumOS 3.1 is based on Ubuntu 18.04 and it is offering the Xfce desktop environment, which brings limited overhead on resources and great flexibility in setting it up to everyone’s taste and needs; the team is backing 9 different variations of the distro for 9 different architectures of Chromebooks and Chromeboxes.


  I tested the GalliumOS specific Bay Trail iso: everything was almost working in the live system, even if the internal sound card volume was very low on both speaker and headset output.


  
    [image: review1]
  


  On the official website (https://galliumos.org/) is to be found a documentation section that, beside other useful pieces of information, gives very precise directions about the installation process, which could be dual-booting with ChromeOS, full ISO installation, or Virtual Machine Installation.


  As planned, I went with the full ISO installation.


  The installer, Ubiquity, is the same as Ubuntu 18.04 except for the branding; it can be started from the live environment.


  After a full update of the new system, and a reboot, GalliumOS was using around 395MB, around 0.5% of my small CPU, and about 5GB of internal storage; after installing the few apps I needed it was using about 6GB out of the 32GB available on the internal storage.


  It was possible to choose a keyboard layout that enabled F keys on the first keys row, which hosts volume, brightness, screens, etc. keys, and a second function activated by the search key in my case (overlay key).


  The touchpad is working smoothly, right-click is mapped as two fingers tap. Both keyboard mapping and touchpad configuration are precious features added by the GalliumOS team.


  There are a few specific GalliumOS themes, including icons and windows decorations, and there’s the compositor Compton running under the hood to grant a nice looking and tearing-free user interface. I tweaked Compton parameters in its configuration file in order to add some transparency to window frames and inactive windows.


  There’s a very limited number of preinstalled applications out of the box, keeping the system lean; as an example there are neither office applications nor games preinstalled.


  We find two GUI package managers: the well known Synaptic, and AppGrid, a visual software boutique presenting the different applications in a grid, as the name is suggesting. I’m used to using the terminal for package management, if I had to choose between AppGrid and Synaptic, my preference goes to Synaptic, by far more responsive. Gdebi is available too, helpful to install packages not coming from the sources managed by apt.


  MenuLibre is pre-installed in order to enable menu customization, there’s Ristretto image viewer and Atril as pdf reader.


  Two media players are available, Audacious for audio files and Mpv for videos.


  The installed browser is Chromium, and the usual good Xfce tools are to be found: Whiskers menu, Thunar file manager, Catfish for file searching, Xfce Terminal emulator and the Xfce Settings manager; inside it is the last one, the panel manager, offering different pre-organized layout with one or two panels.


  Out of the box, GalliumOS shows a lean desktop layout with a bottom bar menu and no icons on the desktop. The collection of pre-installed software is essential, I added neofetch and htop (CLI utilities), Gimp (image editor), qbittorrent (torrent client), Olive (video editor), LibreOffice (office suite), Joplin (note taking tool), and Chrome (web browser) to complete it. Oracle Virtualbox, which I installed and used for Android emulation (see below), is working, of course it is suffering from the limited hardware performance. Snap packages are working, however they are significantly slower, especially when starting up, than the installed packages are.


  I’m definitely not a game player, and we cannot expect high performance from a computer like this, however I tested Super Tux Kart which runs well.


  The project, including bug tracking, is hosted on Github and there’s a friendly community on the Reddit channel, r/GalliumOS. There’s also an IRC channel, I never tested it.


  Till now, after two weeks of use, I had some issues with the internal sound card and I wasn’t able to use my smartphone in usb tethering mode. Expanding a bit on the sound card issues, out of the box the headset mic was not working and the volume was poor on internal sound card; I fixed the two of them by editing the configuration file (HiFi.conf) of my card; furthermore GalliumOS comes with a nice pulse audio interface panel applet, named pastray, which turned out to be the reason for crackling or suddenly muted sound; I replaced it with the standard Xfce volume applet and the issue disappeared.
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  I tried to install Android emulators (Anbox, Genymotion and AndroidX86) with the aim of running Android apps, however my hardware is too weak to run them decently – to be honest, I did not have Android apps support under ChromeOS, and I do not need them.


  Maybe other distributions are more polished than GalliumOS is, however the overall experience is very good – with fast boot, responsiveness, nice looking interface, and long battery life: I do not regret ChromeOS at all.


  Pros


  
    	distro tailor-made for Chromebooks and Chromeboxes.


    	very responsive user interface.


    	limited resources usage, including the internal storage.


    	very good hardware support when compared to other distros.


    	large collection of software.

  


  Cons


  
    	specific to my hardware, issues on internal sound card out of the box.


    	it runs a GalliumOS kernel, apparently not connected with the Ubuntu 18.04 kernel maintenance system.
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  Letters


  Compiled by Ronnie Tucker


  
    If you would like to submit a letter for publication, compliment or complaint, please email it to: letters@fullcirclemagazine.org. PLEASE NOTE: some letters may be edited for space.
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  Q&A


  Compiled by Erik The Unready




  
    If you have a Linux question, email it to: misc@fullcirclemagazine.org, and Erik will answer them in a future issue. Please include as much information as you can about your query.
  


  
    Welcome back to another edition of Questions and Answers! In this section, we will endeavour to answer your Ubuntu questions. Be sure to add details of the version of your operating system and your hardware. I will try to remove any personally identifiable strings from questions, but it is best not to include things like serial numbers, UUIDs, or IP addresses. If your question does not appear immediately, it is just because there is such a lot and I do them, first-come-first-served.
  


  
    Guys, I am getting questions about Laravel and AWS and Celery (Can you eat it?). Let’s try to keep it Ubuntu related. I will try to help, but I am no Oracle of Delphi.
  


  At one stage I worked for an automation company. The turnover on accountants was high. Strangely enough, the accountants were museum pieces, total popcorn toppers (now I am not saying grey power is not a thing, but I suspect some of these had not even seen a computer before). As the company had no IT, they used one of the other divisions, which actually was another company where I worked. The one accountant who had retired from our previous accounting firm came to work for us. The grey, however, was just a cover for the blonde. I would get calls daily regarding printers. This specific individual could not get printers under the belt. She would print until the output tray of the printer was full and when it stopped printing (or ran out of paper), would log a support call. (Sometimes the same document 500 times, which was “never her fault, but the computer’s”). No matter how many times I showed her why it stopped printing, and to remove the paper in time, it went in one ear and out the other. She could also not differentiate between printers marked “accounting” and “hallway” and “drawing office” (even after a few sessions of explaining that “accounting” was for confidential documents, “hallway” was for mass printing, and “drawing office” for odd sizes and drawings). Eventually, this individual was responsible for printing the salaries to the hallway printer and drawing office printer, over and over and over, as it did not appear on the accounting printer. This, in turn, had the effect of a mass resignation by staff (almost half). Sometimes you can’t fix stupid, and they will blame the IT systems, even though said IT systems work as intended.


  
    	Q Is it worthwhile getting the latte panda?


    	A No. You can buy 2 laptops with more powerful processors, for less than a Latte Panda (maybe if the price drops?).


    	Q Guys, I am running Linux Mint and I am trying to upgrade to the latest version of lightzone via PPA, but I cannot get it to work. It just won’t recognize the PPA. Can you help me out with this?


    	A Short answer is you need a different version of Mint. LMDE does not work with PPA’s. If you want to keep the Debian version, you need to build it from source.


    	Q I have a Lenovo 80L0 laptop with Xubuntu 18.04 and I find that my fan runs a lot. I open up my task manager and I see gluqio running more than one instance and each running 15-20% of my 2 Cpu’s. I don’t find anything in the man pages and when I type glu and double tab, there is no result. Do I have malware and how do I get rid of it?


    	A Actually it is gluqlo, which is part of the screen savers, a flip clock IIRC. Xubuntu has a history with screen savers getting stuck or not terminating correctly when you move the mouse or tap a key. The process is not critical and you can kill it.


    	Q I may be stupid here, but I can’t seem to get rid of the spaghetti fonts on my system. If I open the fonts application, it lists all the fonts, but I see only an info button. Delete key has no effect. There is no right-click. Opening it as root has no effect.


    	A The fonts application is just for you to see what the installed fonts look like; you need to install a font manager if you want to delete any.


    	Q I have installed sublime text on Ubuntu to follow along on a tutorial, but if I try to launch it from the command-line – I try sublime or sublimetext – I simply get “sublime: command not found”. I have only recently upgraded from windows, so I am still a bit shaky.


    	A I am not sure why you would need to launch Sublime Text from the command-line, but it is simply: subl - I also liked how you say you “upgraded from Windows”, because in the end, it is an upgrade.


    	Q My question is two-fold. How can I get the software centre to display everything about web development or java in one place. How can I group them or create my own views? Developer tools only gives me “all” or “ide’s.” This is not ideal. Then sometimes I do updates via the software updater, and, once it is done, I go to the software centre and there is an update that the software updater did not show. How is that happening?


    	A OK, the first part, you can’t, not that I know of, but you can install “appgrid” which allows more categories and sub-categories than the software centre. Their development category is broken down into languages as sub-categories. The only catch is you need to page via the arrows on the right, I am not sure if mouse scrolling is supported. The second part, I would say that the update came through just after you did the other one? I use the command-line to update so I cannot really vouch for the GUI versions, but that is the only thing I can think of that may cause that, as all the updates are not released at once.


    	Q I can’t seem to find 20.04 32-bit release. I see that it was discontinued. I have an Acer laptop with 32-bit Ubuntu, and was planning on upgrading as soon as the new LTS was being released. For some reason I can’t load 64-bit, it always crashes, but 32-bit works. My Specs: CPU: T2250, MEM: 2GB


    	A That is very strange, to be sure, as that machine should support 64-bit. You will have to get an “Ubuntu spin” that is 32-bit, to partake in the 20.04 goodness (if at all). At this stage of the game, I cannot tell you which, but keep your peepers peeled for a 32-bit respin.


    	Q May I ask you a question about programming? I thought I shouldn't learn python because everyone is trying to learn it 😅 I want to make fast programs. Also, I want to be a pro programmer. So I chose Rust. Do you think it is wrong to think like that? Rust will teach me what is going on behind the scenes? I have heard python can’t teach that.


    	A Whew. I am no programmer, but here goes. Both Python and Rust are high-level programming languages and won’t really teach you what is “behind the scenes”. For that, you need to learn assembler. That will also write the fastest programs. However, do not write off Python. Go ahead and learn Rust, it seems a lot of the “big players” are moving that way.


    	Q Is it possible to install Ubuntu or Debian packages in Solus? I need some applications I use in Ubuntu on Solus, but it is not in their software center.


    	A The short answer is no, the longer answer is: build it from source.


    	Q I have an HP 14Z laptop that came with a 30GB SSD for caching on windows. I installed Ubuntu 20.04 on it and it works. How can I now see the other hard drive, the 1TB?


    	A Open your “disks” application if you need to format it. Uninitialised volumes do not usually show up in the file manager.


    	Q My Lenovo laptop is a decade old, and I want to run lmsensors/ psensors on it to monitor it, as it is so old. Problem is, it installs, but I get nothing. Not even a blip. No temps, no fan, etc.


    	A Microsoft. The vendor and Microsoft worked together (colluded?) so that it works only with Windows. Other than writing the device drivers yourself, write it off to that. Some things are just not to be. (That's not my experience with my old Lenovo laptops. I use sensors (part of lmsensors) with Conky. - Gord)


    	Q What is the best way to check out my CPU on Ubuntu, I have tried inxi, neofetch, and checked procinfo, but it’s kinda lacking, if you know what I mean?


    	A Actually, I don’t, but if you want more info on your processor, I suggest you look at “GPU-Z” or “GPU-X”. Get back to me if this is not what you are looking for.


    	Q I have set up quite an extensive hosts file in Ubuntu. I have been noticing that Firefox is not respecting my hosts file lately (blocked domains are spewing their nonsense all over my web pages). Do I need to switch to Brave now or something?


    	A You can’t have your cake and eat it. Either you rely on your hosts file or you use encrypted DNS inside of Firefox. I hope this can be fixed in the future, but for now it’s one or the other. Turn it off in the Firefox settings if you prefer your own.


    	Q I kinda had a drive failure in my array, but it is el-cheapo, so it had no light to point out which drive failed. I can’t access it anyway. So I removed the drives and tested them one by one. Now I can’t remember in which order they go back in. Is there a way for me to recover my data? I am still on Ubuntu 16.04 tho.


    	A Yes, with very expensive software or take it to a data recovery centre.


    	Q I have a question that may sound stupid. How do you guys know what the PID of a process is to kill it. A lot of times in Xubuntu, I use the task manager to kill a process that is stuck, but that ends up stuck too. How do I find that PID to kill it?


    	A I am not sure I follow, but I think I understand. If you use a graphical program to end another program, and that does not kill it, but seems to sit there doing nothing? Well, your fallback is the terminal. You can kill the process with -9 as superuser. Also, task manager is just another process, if you want to kill that. You can find its PID with top or htop.


    	Q I installed ZorinOS on my machine and it is beautiful. The one thing that gets my goat is whenever I use it, it will randomly freeze or hang. Sometimes I can use it for an hour, and sometimes one minute before it freezes. Because it froze, it did not write any log files either. So now how do I know what is causing it?


    	A You can try uninstalling java / openjdk / JRE for a start, but I had the same issues, so I put Zorin aside and will check out the next version.


    	Q How can I change my audio settings in Ubuntu Gnome to run my headphones and my speakers on my dell 5490 laptop please? It is a built-in sound card with a 3.5mm jack, one jack only. I have googled all over, looking for the answer, and even stack-overflow cannot help me.


    	A I am sure we have had this before, but here goes: You simply can not. I will tell you why. The laptop you are using is a business-class laptop. Corners are cut. The 3.5mm jack just interrupts the flow of electricity to the speakers. In other words, it re-routes the “traffic” to your headphones, physically (ie, software won’t make a difference). You need to look for an external sound card that is well supported in Linux.


    	Q Quick one. I am currently using ultraviewer to connect to my mom’s windows PC. The thing is that I no longer want to keep a windows virtual machine in Vmware just for that, as VMWare slows down Ubuntu 18.04 to a crawl. My machine has 8 GB of memory, but it is only an i3. How can I run ultraviewer in proton or whatever to make it work?


    	A You have me there, have you considered a Linux-friendly alternative like Wayke or Anydesk? They work great on both OS’s.


    	Q How can I run Gparted on Ubuntu without sudo? I want to format some SD cards.


    	A You can’t as you need root access to perform destructive operations. Does ‘disks’ not work for you?

  


  
    Erik has been in IT for 30+ years. He has seen technology come and go. From repairing washing machine sized hard drives with multimeters and oscilloscopes, laying cable, to scaling 3G towers, he's done it.
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  Ubuntu Games - Tonight we riot


  Written by Erik


  Website: https://tonightweriot.com/


  Price: $15 on GOG / Itch.io


  Blurb:“tonight we riot is a revolutionary crowd brawler about worker liberation and lobbing molotovs at mech suits & crazy bosses!“


  and


  “In a dystopia where wealthy capitalists control elections, media, and the lives of working people, we’re faced with two choices -- accept it or fight for something better. (Isn’t that what we have now???? -E)


  Tonight We Riot doesn’t have just one hero. Instead, you play as a movement of people whose wellbeing determines the success of your revolution.”
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  Time to don our socialist big girl pants and take on the PoPo!!


  The first thing I want to talk about is the sound. I let the intro play all the way through and waited for the melody to finish. Go listen here: https://www.youtube.com/watch?v=W9Lrw5OOn1Uv - The music is top notch. The synthwave genre takes the retro rumble to a futuristic retro rumble. The game sounds are there and they are okay, I suppose, but I would suggest that you leave the music on. (Honestly, I was expecting Katyusha or something similar, so the music was the surprise).


  With that out of the way, what is Tonight We Riot? In essence, it is a beat-em-up where you are the flag runner. Somehow it reminds me of ‘river city ransom’, another pixelated beat-em-up. You move from left to right on the screen and beat up any cops in your way, to liberate the workers. After you have liberated all the workers in one section, you will reach the end and the rich bosses will flee in terror. You will get rated on how well you did and how many of your followers survived. That is the main game loop. Every level, there are new enemies and new weapons, to keep things interesting. It is not only the police and the wealthy that are your enemies. The terrain can be an enemy too, so choose your path well. Objects on screen can be moved or destroyed, the choice is yours, but again, realise that an exploding propane tank will kill anyone near it. Your progress is measured on an overhead map, a-la Mario. You can skip a level at any time and go directly to the next.
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  This is a single-player game or a two-player game. You and your partner in crime or fellow revolutionary, get to wield weapons and fists as well as projectiles. Every so often you will encounter some helpful bricks or Molotov cocktails on the road. You can earn weapons by keeping your followers alive, things like baseball bats or wrenches. That said, you better not die either. You have the standard health bar and weapons type indicator. If you die, another revolutionary takes over, until none are “left” or left...


  Different weapons on either side have different effects, for instance, tear gas will make your crowd disperse, where bullets will kill them. Not everything is static as you move from left to right either, vans filled with riot police will ride onto the screen and offload some cops. Water cannons will counter your ranged attacks. Now even if this is a cheeky game, with lots of violence and killing cops, one should remember to take it with a pinch of salt. (When you want to hit a dog, you will find a stick).


  Though there is an option to play this game by keyboard, I would suggest getting a controller, as this was designed around a controller. It is meant to be a fast paced, beat-em-up, endless runner, and this is where a gamepad shines. It is not that the game is unplayable with the keyboard, far from it, the better option here is just mindlessly mash your buttons and bumpers.


  The graphics are a bit of a mixed bag for me; some of the pixel art is gorgeous and some looks very lazy. Especially the characters. They look like an afterthought that is stuck between 8-bit an 16-bit graphics. Some of the stages and vehicles have a really stunning look to them, and others are not so good. Somewhere along the line you even have a dog join your cause. It would have been spectacular if there was more detail; at the moment, the dog reminds me of Snoopy, badly drawn. The news is a nice touch and advances the story as you play. The shiny news anchors and other characters are well drawn.
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  The game is challenging, and not for those with OCD. You cannot save all your comrades all the time. Though you can try, I suggest you do not worry too much; the pixelated murder, and mayhem, should just be part of the background noise, while you enjoy the ruckus. It is a barrel of fun, nonetheless, so whip out those capitalist dollars and buy this game. Trust me, you will have a riot, one way or another. *wink. I have the GOG version, and everything worked great as expected on Ubuntu. Touch wood, but so far I haven’t had an issue with the GOG installer on Ubuntu 14 through 18.


  The question now remains, is it worth the $15. Well if you are in a country where fifteen bucks is fifteen bucks, sure. The thing is if you are in another country, where fifteen bucks is two hundred bucks, then maybe not. Try to look for regional pricing.




  
    Erik has been in IT for 30+ years. He has seen technology come and go. From repairing washing machine sized hard drives with multimeters and oscilloscopes, laying cable, to scaling 3G towers, he's done it.
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  Patrons and Donors
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  The current site was created thanks to Lucas Westermann (Mr. Command & Conquer) who took on the task of completely rebuilding the site, and scripts, from scratch, in his own time. The Patreon page is to help pay the domain and hosting fees. The yearly target was quickly reached thanks to those listed on this page. The money also helps with the new mailing list that I set up.


  Several people have asked for a PayPal (single donation) option, so I ’ve added a button to the right side of the website.


  A big thank you to all those who’ve used Patreon and the PayPal button. It’s a HUGE help.
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  https://www.patreon.com/fullcirclemagazine
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  https://paypal.me/ronnietucker
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  https://donorbox.org/recurring-monthly-donation


  


  Monthly Patrons


  Alex Crabtree
Alex Popescu
Bill Berninghausen
Brian Bogdan
CBinMV
Darren
Dennis Mack
Devin McPherson
Doug Bruce
Elizabeth K. Joseph
Eric Meddleton
George Smith
Henry D Mills
Hugo Sutherland
Jack
Joao Cantinho Lopes
John Andrews
John Malon
John Prigge
JT
Kevin O'Brien
Lee Allen
Leo Paesen
Linda P
Mark Shuttleworth
Norman Phillips
Oscar Rivera
Paul Anderson
Paul Readovin
Rob Fitzgerald
Roy Milner
Scott Mack
Sony Varghese
Tom Bell
Tony
Vincent Jobard
Volker Bradley
William von Hagen
Taylor Conroy



  Single Donations


  2020:


  alex moro
Ronald Eike
Alexandru Popescu
Linda Prinsen
Glenn Heaton
Jon Loveless
Frank Dinger
Raymond Mccarthy
Daniel Rojo
Frits van Leeuwen
Peter Swentzel
Anthony Cooper
Dale Reisfield
Gavin Thompson
Brian Kelly
Ronald Eike
Michael Grugel
Glenn Nelson
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  How to Contribute


  
    FULL CIRCLE NEEDS YOU! 

    A magazine isn’t a magazine without articles and Full Circle is no exception. We need your opinions, desktops, stories, how-to’s, reviews, and anything else you want to tell your fellow *buntu users. Send your articles to: articles@fullcirclemagazine.org


    We are always looking for new articles to include in Full Circle. For help and advice please see the Official Full Circle Style Guide : http://bit.ly/fcmwriting
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            FCM #161 Deadline: Sunday 6th September 2020. Release: Friday 25th September 2020.
          
        

      
    

  


  
    	Send your comments or Linux experiences to: letters@fullcirclemagazine.org


    	Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org


    	Questions for Q&A should go to: questions@fullcirclemagazine.org Desktop screens should be emailed to: misc@fullcirclemagazine.org


    	… or you can visit our site via: fullcirclemagazine.org

  


  
    Full Circle Team 

    Editor - Ronnie Tucker - ronnie@fullcirclemagazine.org


    Webmaster - Lucas Westermann - admin@fullcirclemagazine.org


    Editing & Proofreading: Mike Kennedy, Lucas Westermann, Gord Campbell, Robert Orsino, Josh Hertel, Bert Jerred, Jim Dyer and Emily Gonyer


    Our thanks go out to Canonical, to the many translation teams around the world, and to Thorsten Wilms for the FCM logo.

  


  
    FCM PATREON : https://www.patreon.com/fullcirclemagazine
  


  Getting Full Circle Magazine:
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          EPUB Format - Most editions of Full Circle have a link to the epub file on the downloads page. If you have any problems with the epub file, you can drop an email to: mobile@fullcirclemagazine.org
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          Magzster - You can also read Full Circle online via Magzster: http://www.magzter.com/publishers/Full-Circle. Please share and rate FCM as it helps to spread the word about FCM and Ubuntu Linux.
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          Issuu - You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to spread the word about FCM and Ubuntu Linux.
        
      

    
  


  


  For the Full Circle Weekly News:
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          You can keep up to date with the Weekly News using the RSS feed: http://fullcirclemagazine.org/feed/podcast
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          Or, if you’re out and about, you can get the Weekly News via Stitcher Radio (Android/iOS/web): http://www.stitcher.com/s?fid=85347&refid=stpr
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          and via TuneIn at: http://tunein.com/radio/Full-Circle-Weekly-News-p855064/
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Greg's Cookbook - Mongolian Beef and Spring Onions - Recipe ID 166

Mongolian Beef and Spring Onions

Source: https://www.allrecipes.com/recipe/201849/mongolian-beef-and-spring-onions/

Servings Total Time Ratings
4 serving(s) 30 minutes 0
Instructions:
Ingredients:
Heat 2 teaspoons of vegetable oil in a saucepan over medium heat, and cook and
- 2 teaspoons vegetable oil stir the garlic and ginger until they release their fragrance, about 30 seconds
- 1 tablespoon finely chopped garlic Pour in the soy sauce, water, and brown sugar. Raise the heat to medium-high
- 1/2 teaspoon grated fresh ginger root and stir 4 minutes, until the sugar has dissolved and the sauce boils and
- 1/2 cup soy sauce slightly thickens. Remove sauce from the heat, and set aside. Place the sliced
- 1/2 cup water beef into a bowl, and stir the cornstarch into the beef, coating it thoroughly
- 2/3 cup dark brown sugar Allow the beef and cornstarch to sit until most of the juices from the meat have
- 1 pound beef flank steak, sliced 1/4 inch thick on the diagonal been absorbed by the cornstarch, about 10 minutes. Heat the vegetable oil in a
- 1/4 cup cornstarch deep-sided skillet or wok to 375 degrees F (190 degrees C). Shake excess
- 1 cup vegetable oil for frying cornstarch from the beef slices, and drop them into the hot oil, a few at a
- 2 bunches green onions, cut in 2-inch lengths time. Stir briefly, and fry until the edges become crisp and start to brown,

about 2 minutes. Remove the beef from the oil with a large slotted spoon, and
allow to drain on paper towels to remove excess oil. Pour the oil out of the skillet or wok, and return the pan to medium heat. Return the beef slices to the
pan, stir briefly, and pour in the reserved sauce. Stir once or twice to combine, and add the green onions. Bring the mixture to a boil, and cook until the
onions have softened and turned bright green, about 2 minutes.
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2 teaspoons vegetable ol
1 tablespoon finely chopped gariic

1/2 teaspoon grated fresh ginger root

1/2 cup soy sauce

12 cup water

2/3 cup dark brown sugar

1 pound beef flank steak, siiced 1/4 inch thick on the diagonal
1/4 cup comstarch

1 cup vegetable il for frying

2 bunches green onions, cut in 24nch lengths.





OEBPS/Images/patreon.png
(® patfreon





OEBPS/Images/raw3.png
“ RawTherapee 5.8- /home/gewgaw/Pictures/Namibia/DSC_0806.JPG - o
= om & Processing Profiles

E o = (Custom) -mpRE
; |

3 s ooz xxmw

- © White Balance

= I & Vibrance

‘ 2 ... o ®AALL &

S Navigator .

& Pastel Tones

Protect skin-tones

+ Avoid coll

 Linkpastel irated tones

Skin-tones:  HH. / -

© Channel Mixer
o Black-and-White
o HSV Equalizer

o Film Simulation
Snapshots - o Soft Light
o RGB Curves

o Color Toning

» Color Management

— _ Y @ \® Ready None ~ el QAQ





OEBPS/Images/raw4.png
6] RawTherapee 5.8 - /home/gewgaw/Pictures/Namibia/DSC_0806.JPG -
D Off Persn @ O o # O Processing Profiles
Z '
3|8 = (Custom) -mpRE
z in
S m A N
8 5 EFeoxrEM
= - » Exposure
& Shadows/Highlights
g f— & Tone Mapping 1
S Navigator Strength 050 = +
a -
o Gamma 100 = +
g Edge stopping 2417=F
3 ; P — =
o # > Scale 0.10 +
ST i Reweighting iterates 1=+
Width: 4512, Height: 3000 - -
7! 1548 Sy
X 4479, 154 2 © Dynamic Range Compression il
R: 682% H: 19.7° L 49.1 o & -
G: 36.9% S 68.4% a 309 e © Vignette Filter
B 216% V. 682% b 369 - - © Graduated Filter

o L*a*b* Adjustments

Snapshots 5 5 SRl *&?ﬁ.*@”
£

+ S ge® M - B el QARAQ





OEBPS/Images/160cover.png
® Full Circle
0000 Ogh

Live session user

A S
REVIEW OF GALLIUMOS 3.1

LIGHTWEIGHT D OR CHROMEOS DEVICES





OEBPS/Images/comic70.jpeg
Tuping with ane
flipper.. The
struggle is real!

C)

The Daily Waddle





OEBPS/Images/audacity_log.jpg





OEBPS/Images/return.png
RETURN TO CONTENTS






OEBPS/Images/krita2.png





OEBPS/Images/every1.jpg





OEBPS/Images/every14.jpg
A o r%%
e

& = gmn il 1 o
BB EEN R
iP@amMapDe®EL [V






OEBPS/Images/cc1.png
W mainss- /home/gewgaw/RUST/IeSsond/sic - GEANY. L e
File Edit Search View Document Project Build Tools Help

B -O-B&@ <& <> T #-m ¢ <

< Documents )  mainrs

~ 8 ~/RUST...son4/src struct PlayerCharacter

1

e
3 name: String,
4 gender: String,
5 strength: us,
6 agility: us,
R
8
9 fn main()
10 &a{
1 let character = Playercharacter
12 o {
13 name: String: :from("Tanis Thunderhammer"),
14 gender: String: :from("male"),
15 strength: 16,
16 agility: 13,
17 b
18
19 println! (*{} has entered the keep!", character.name);
20 |}
2

~ 6|  agility: us,
| Jeovvis bovvs
Scribble

Finished dev [unoptimized + debuginfo] target(s) in 0.62s
Running target/debug/lessond”
" Tanis Thunderhammer has entered the keep!
gewgaw @ Aangeneem ~/RUST/lessond
S| I

line:19/21 cokS7 seb0 INS TAB mode:LF encoding: UTF8 filetype: Rust ~scope:main
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